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Step-by-Step Tutorial  - Notating Jingle Bells
(The Table of Contents and complete user’s guide follow this tutorial.)

The purpose of this tutorial is to help you become familiar with how to enter a score from start to finish by
notating the song “Jingle Bells.” The focus is on note and symbol entry, with some music basics. The final
score is in the Samples folder as file jingle.nwc. In addition, a printed copy of the song file is shown below.
While working through this tutorial, it may be helpful to have the file jingle.nwc open as a reference. Use
File: Open Samples… to access the song file jingle.nwc.

Jingle Bells

Copyright © 2011 by NoteWorthy Software, Inc.
All Rights Reserved

Jin gle- bells, jin gle- bells, jin gle- all the way,
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Creating a new file
To start, you will need to create a new song file. It will be used to notate the song “Jingle Bells.” To start a
new song file, do one of the following:

� Select the File menu option and New.

� Click the New File  icon.

� Press Ctrl+N .

Once you have started a new song file, the Song Templates dialog box will appear. There are several song
templates to select from, but we will start a song from scratch. With <Blank Score> selected from the
General tab, click OK  to start a new empty file.

Next, the File Info  dialog box is presented. This area allows you to enter information about the song. The
title, author, lyricist and copyright information entered in this dialog box is used when printing the song
file. Enter Jingle Bells for the Title. Any of this information can be changed if you wish. The Comments
section is where you can add any extra information about the song. If you like, type in: My notation of
Jingle Bells. Once you have entered the information, select OK .

Note: You can always change the song information in this screen at a later date. To access the File Info,
do one of the following:

� Select the File menu option and Info .

� Click the Authoring Info  icon.

� Press Ctrl+I .

Adding, Naming and Connecting Staves
After clicking OK in the File Info  dialog box, the editing screen will appear with one staff. “Jingle Bells”
has two staves, so you need to add another staff.

To add another staff, use one of the following procedures:

� Select the Staff menu option and New Staff.

� Click the New Staff   icon.

� Press Ctrl+A .

Note: When editing a song in NoteWorthy Composer, the staff (or staves) extend to the right as if on a time
axis. When you Print or Print Preview the staff (or staves) will be wrapped like in sheet music. Look at the
sample song jingle.nwc. This is a song with 2 staves. You will see on the display screen for editing and
playing back, the staves move to the right. But if you go to File: Print Preview, the staves are wrapped.

Now, the two staves need to be named. In addition, you need to put a piano brace at the start of the two
staves. You will work with the upper staff first. Click the top staff to make it active. Open the Staff
Properties dialog box by doing one of the following:

� Select the Staff menu option and Staff Properties.

� Press F2.

� Right mouse click and select Staff Properties.

Under the General tab, rename the staff currently listed as Staff to Right Hand. To frame the staff with a
brace as in piano format, click the Visual tab and check Grand Staff Brace and Bars Connected. Click
OK . The lower staff will need to be set before the brace will be drawn.
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Make the lower staff active by doing one of the following:

� Click the lower staff.

� Press Page Down.

Note: You know a staff is active when the cursor is flashing in it. To make the active staff more obvious,
you can change the staff colors for NoteWorthy Composer by selecting Tools: Options and clicking the
Color tab and setting Active Staff. A colored bar will also appear in the Staff Label panel along the left
side of the work space.

Using Staff Properties (F2), under the General tab, replace the Staff Name with Left Hand.

To add a Staff Label to the Brace, make the top staff active, press F2 (for Staff Properties), for Staff Label
(under the General tab), enter Piano or any name you choose for the staves. For more on Staff Name and
Staff Label, see page 32.

Time to Save
To preserve your work, you should save the file now and occasionally while working on the score. To save
a file, do one of the following:

� Go to the File menu and select Save.

� Click the Save File  icon.

� Press Ctrl+S.

Here you can name the file and place it in your Documents folder. Since jingle.nwc is the original file
name, you may want to save your file as jingle2.nwc. It is best to save your song files in a different folder
than the NoteWorthy Composer program folder. You can set the default location for saved files in Tools:
Options, Folders tab.

Clef, Time Signature and Key Signature Entry
At the beginning of most songs you will find a clef, a time signature and a key signature. You will enter
these items by working with the upper staff first and return to the lower staff later. Since “Jingle Bells” is a
two-handed piano score, a treble clef is needed in the top staff.

The insertion point plays a key role in note and symbol entry. It is the flashing marker in the staff that
determines where items will be placed. This placement indicates where a new entry will be before and after
items, as well as where it will be vertically on the staff. For clef and signature entries, the vertical position
is not important, as the sign will be centered automatically. However, it will be important for note entry to
place notes at the right pitch. If you make a mistake and need to delete items, place your insertion to the
right of the item and press Backspace or place your insertion point to the left of the item and press Delete.
You can also use Edit: Undo (Ctrl+Z).

To add the treble clef, make sure the insertion point is within the lines of the top staff. Access the Clef
dialog box in one of the following ways:

� Select the Insert menu option and Clef.

� Right click mouse, select Notation: Clef.

� Press the quick key C or c.

Once the Clef dialog box is open, select Treble Clef and click OK .

a
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If you are using the Insert Tool Bar, you can simply click the Treble
Clef icon to place the clef on the active staff at the insertion point.

Note: The Insert Tool Bar (which by default appears vertically along the left of the work space) allows
fast point and click entry of some common symbols. However, you are not always provided access to the
symbol’s dialog box and possible advanced features. For example, when you point and click on the Treble
Clef, the clef is placed on the staff. However, if you use Insert: Clef, the dialog box will be presented and
you can see that you can set the octave shift, and change the color under the Visibility tab (if you have
unchecked “Smart Properties Insert” in Tools: Options, Editor tab). During this tutorial, instead of using the
Insert Tool Bar you may want to use the Insert menu and look at the dialog box for the symbols. That way,
you will know what else is available if you should need these features in future work.

Next, you will need to enter the key signature. The key of “Jingle Bells” is F Major. To access the Key
Signature dialog box, use one of the following:

� Select the Insert menu option and Key Signature.

� Right click mouse, select Notation: Key Signature.

� Press the quick key K  or k.

� Click the        icon in the Insert Tool Bar

In the box, select F Major  and click OK .

If you are not familiar with the key signatures, there is a chart in the Appendix of this user’s guide.

Now, the time signature needs to be entered. The time signature is written like a mathematical fraction
which indicates the number of beats per measure (top number) and which note gets one beat (bottom
number). The sample song “Jingle Bells” uses 4/4 time. Thus, there will be 4 beats per measure and a
quarter note is one beat. To open the Time Signature box, do one of the below:

� Select the Insert menu option and Time Signature.

� Right click mouse, select Notation: Time Signature.

� Press the quick key G or g.

In the Time Signature dialog box, type 4 in for Beats per Measure and for Value for Beat. Click OK .

Using the Insert Tool Bar, you can simply click the 4/4 icon to place
the 4/4 time signature on the active staff at the insertion point.

Note Entry
There are several ways to enter notes and you will probably try them all before you find the style you like
best. As you work with NoteWorthy Composer, you will develop the method that is right for you. This
section starts with the point and click method and moves towards quick keys.

MIDI keyboard entry is not covered here, see page 70 for MIDI input instructions. Notes can also
be entered with the piano tool bar. See the toolbar section on page 5 for more details.

The first note in “Jingle Bells” is a quarter note in the A position with a staccato. The staccato mark means
to play the note short, or detached. To place the first note using the mouse:

1. Click the Quarter Duration  icon.

2. Click the Staccato  icon.

3. Click the A position in the upper staff (the second space from the bottom), to the right of the
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time signature. You should see the insertion point blinking in the A position

4. Press Enter.

The second note is the same. To place the second note using quick keys:

1. Press the number 3 for quarter duration.

2. Press the comma ( , ) for a staccato.

3. Place the insertion point in the A position using the ↑↓ arrow keys.

4. Press Enter.

Enter the third note using one of the above methods or try your own combination.

Tips for entering notes:

���� If you do not know the action an icon represents, hold the cursor over the icon and a tool tip will
appear with the command name and, if available, its quick key in parentheses.

���� Icons may be on (white background), off or unavailable (grayed out). If an icon is on, it is ready to
be used. Turning an icon on while notes are selected will perform the action represented by the
icon. Turning an icon off while notes are selected will reverse the action. If an icon is grayed out,
items have not been selected for which the icon can be used.

���� To prevent auto-reset of some icons during note entry, select Notes: Persistent Note Tools or click
the       icon to select tools that you do not want reset.

Rest Entry
After the three staccato quarter notes, there is a quarter rest. To choose the duration for the rest, select the
quarter duration. These are the same icons you have been selecting to enter notes. To enter the rest:

1. Place the insertion point to the right of the last note
entered.

2. Click the Quarter Duration  icon or press 3.

3. Press the Space Bar.

Remember: Enter inserts a note and Space Bar inserts a rest. The note duration icons select the duration
for both.

Bar Line Entry
At the beginning, 4/4 was selected as the time signature, meaning there will be four beats per measure and a
quarter note is one beat. So far, you have entered 3 quarter notes and 1 quarter rest, which equals four beats
and makes a measure.

Measures are divided by bar lines. To add a bar line, place the insertion point to the right of the quarter
rest and select one of the following:

� Go to the Insert menu and select Bar Line .

� Right click mouse and select Bar Line .

� Press the Tab key.

� Press the *  key.

n
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Measure Numbers
You can automatically number the measures in a song to keep your place. You may want to do this for your
“Jingle Bells” file and the jingle.nwc file. To enter measure numbers:

1. Select File: Page Setup.

2. Click the Options tab.

3. At Measure Numbers, select one of the options other than None.

4. For Measure Start, enter 1.

5. Click OK .

More Notes
Continue entering notes in the next two measures until you reach the dotted quarter note. The dot to the
right of the quarter note means it gets an extra half beat. The dot is placed in the same manner as the
staccato. To enter the dotted quarter note:

1. Click the Quarter Duration  icon or press 3.

2. Click the Dotted Duration  icon or press the period key ( . ).

3. Place the insertion point in the F position, the first space from the bottom.

4. Press Enter.

Continue notating the upper staff through measure 6. The last two notes of measure 6 are beamed eighth
notes. The notes need to be entered as individual eighth notes first. To beam flagged notes, select
(highlight) the notes and choose one of the following:

� Select the Edit  menu and Beam.

� Click the Beam Selected Notes        icon.

� Press Ctrl+B .

Note: The Beam command will not be available until you have selected notes that can be beamed; for
example, 2 or more eighth notes. If you do not understand how to select notes, see page 10 under
“Selecting.”

kz kz
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Special Endings and Repeats
The first ending of “Jingle Bells” is different from the final ending. Special endings and a repeat will be
used to indicate the direction of play. To enter the special ending:

1. Place the insertion point at the beginning of measure 7.

2. Select Insert: Special Ending, press the S key or click the       icon.

3. Click the 1st Ending box if it is not already checked.

4. Click OK  and measure 7 should have a special ending 1 notice.
5. Place the insertion point at the beginning of measure 8 and press the S key.
6. Check “Continue prior ending” and Closed ending.  Click OK .

Enter the notes in measure 7 of the upper staff.

Measure 8 in the upper staff has a slur. A slur means to play the connected notes in a smooth manner, as if
they really are connected. To enter the slurred notes:

1. Click the Half Duration  icon or press 2.

2. Click the Slur  icon or press the semicolon ( ; ).

3. Place the insertion point in the G position and press Enter.

4. If the Slur property is still enabled, turn it off now.

5. Place the insertion point in the C position and press Enter.

The two notes are now connected with a slur.

You have reached the end of the first pass. There needs to be some indication to the player to go back to the
beginning and play it again. This is done using a repeat. To open the Bar Lines dialog box, do one of the
following:

� Select Insert: Bar Line (Decorated).

� Right click mouse, select Notation: Bar Line (Decorated).

� Press the quick key B or b.

In the Bar Lines dialog box, select the Master Repeat Close and click OK . This should place the repeat at
the end of measure 8. The difference between the Master Repeat Close and the Local Repeat Close is the
Master Repeat Close is used at an ending while the Local Repeat Close is used in the middle of a verse. See
the repeatx.nwc files in the Samples directory for more detail on repeats. For each file, go to File: Info for
an explanation.

At the start of measure 9, insert the second special ending, just as you did for the first, except select 2nd
Ending under the Special Ending tab.

Finish entering the notes in the top staff for “Jingle Bells.”

is to ride in a onehorse- o pen- sleigh.
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Selecting an Instrument for Play Back
It is important to select an instrument for play back for your staves. Without selecting an instrument, your
song will use the instrument last played on that channel of your sound card.

To select an instrument for the upper staff:

1. Click the upper staff to make it active.

2. Press F2 to open the Staff Properties dialog box.

3. Click the Instrument  tab.

4. Click Predefined Instruments…. Click General MIDI, Piano, Bright Acoustic Piano, OK. The
instrument selections are a function of your sound card (or other play back device). If you do not have
this specific piano, select any piano or any other instrument.

You need to follow this same procedure to select an instrument for the lower staff.

In “Jingle Bells,” you will use the same instrument for both staves. However, when you work with songs
with several instruments, each different instrument needs to be assigned to a different channel on your
sound card. As you add staves to your song, NoteWorthy Composer automatically assigns each staff to a
new channel, as long as channels are available. If you add more staves than available channels, you can
assign staves with the same instrument to the same channel. The channel is set with Staff: Staff Properties,
MIDI, Channel.

You can view all the staves with their channel and patch assignment with the Tools: Score Review
command. For more information about channels, see page 24.

Configuring for Sound - Play Back
Even though you have not finished notating the song, you can play back what you have created at any time.
If you have not done so already, you need to configure NoteWorthy Composer for sound. This means you
need to tell NoteWorthy Composer what device to use for play back. The directions for configuring
NoteWorthy Composer for sound can be found in the Help menu, select Getting Started, Index tab and
Configuring for Sound, and on page 23.

Once you are setup for sound, you can choose where you want NoteWorthy Composer to begin play back.
Go to the Tools menu and select Options. In the dialog box, click the Midi  tab. Here you can select Play to
be from beginning, from insertion point, from current measure or a few measures back. For now, choose
play from beginning. But remember you can come back and change this later. Click OK .

Now you are ready to play back. To start play:

� Select the Tools menu option and Play.

� Click the Play Song  icon.

� Press the quick key F5.

You should hear the upper staff of “Jingle Bells” play as the notes are highlighted. If you do not hear play
back, search the Help file for “faq: Problems with play back.”

To stop play:

� Select the Tools menu option and Stop.

� Click the Stop Play  icon.

� Press the quick key F6.

� Press the ESC key.
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Notate the Lower Staff
Just as you started the upper staff with the clef and signatures, the same must be done for the lower staff.
But this time, you can copy from what you have already done in the upper staff and paste it in the lower
staff. To copy and paste:

1. Select (highlight) the treble clef, the key signature and time signature in the upper staff. (See
Selecting on page 10 for how to select.)

2. Click the Copy Selection  icon or press Ctrl+C .

3. Press Page Down to place the insertion point in the bottom staff.

4. Click the Paste Selection  icon or press Ctrl+V .

Congratulations! If you now have a treble clef, a key signature and a time signature in both the upper and
lower staves, you have successfully copied and pasted. However, there is some tidying up to do.

First, the lower staff needs a bass clef instead of a treble clef. To change this, select the treble clef in the
lower staff (use the mouse or shift+arrow keys). Now, press Alt+Enter . This is the Edit: Properties
command and is used to edit the properties of an item you have selected (highlighted). After pressing
Alt+Enter, the Clef dialog box will appear allowing you to a select bass clef. Choose Bass Clef and click
OK . There should now be a bass clef in the lower staff.

Your key signature may not be properly aligned so press F9 (View: Refresh Score) to refresh the score.
This will update the staff to the new key signature.

Chord Entry
In “Jingle Bells,” the lower staff, or left-hand part for piano play, contains all chords (notes aligned
vertically and played at the same time). Chords supply the harmony for the melody being played on the
upper staff, or right-hand part.

There is just one extra step to placing a note in a chord as opposed to spacing it out by itself. To create a
chord:

1. Enter the first note as usual.

2. Place the insertion point to the right of the first note
and at the correct pitch for the second note.

3. Press Ctrl+Enter  to place the second note in the
chord.

4. Repeat steps 2 & 3 to add more notes to a chord.

Now that you know how to enter Chords, enter all the chords through measure 6. If you make a mistake in
a chord, you can easily remove a chord member. To remove a chord member:

1. Place the insertion point to the right of the note you want to delete.

2. Press Ctrl+Backspace or select Edit: Remove Chord Note.

You can read more about the rules of chord entry in the Help File. Search on Chord Member command.

b i
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Special Endings in the Lower Staff
You also need to add the special endings in the bottom staff. Only the top ending will appear in the printed
copy. However, NoteWorthy Composer needs the ending in all staves to know where to go while playing
each staff.

You can select and copy (Ctrl+C ) each special ending and the repeat bar in the upper staff and paste
(Ctrl+V ) them in the lower staff. Or, use the appropriate commands. Add the notes as necessary in these
measures until you have finished.

Play the Final Song
You have now completed your notation of “Jingle Bells.” If you have not saved recently, do so now (File:
Save, Ctrl+S or click the Save File  icon). Play back of “Jingle Bells” will begin where you selected it
to with the Options command. If you did not choose to play from the beginning, scroll back to the
beginning or press the Home key. If you did select play from the beginning, NoteWorthy Composer will
scroll there automatically at the start of play. Start play from the menu (Tools: Play), click the Play Song

 icon or press F5.

You can also select one staff to play back at a time. To only play the top staff:

1. Click the upper staff to make it active.

2. Press Shift+F5.

You can also mute one or more staves for play back. To mute a staff:

1. Click the upper staff to make it active.

2. Click the Mute Staff        icon.

If you have several staves to mute, use Tools: Mute List (quick key M or m).

Lyrics
Even though you have finished the notation and your song sounds great, the lyrics need to be added.
NoteWorthy Composer can handle up to 8 lyric lines, but this version of “Jingle Bells” will use only one
lyric line. To enter lyrics:

1. Make the upper staff (the staff the lyrics will be attached to) the active staff by clicking it.

2. Select Edit: Lyrics  or press Ctrl+L .

3. On the Configuration  tab, set the Line Count to be 1 Lyric Line .

4. Click the Lyric 1  tab. The other numbered tabs are for additional lyric lines and will not be
used for this song.

5. Type in the following text for lyrics, pressing Enter at the end of each line:

Jin-gle bells, jin-gle bells, jin-gle all the way,
Oh, what fun it is to ride in a one-horse o-pen sleigh.
one-horse o-pen sleigh

6. Once the lyrics are entered, the OK  button must be clicked for NoteWorthy Composer to
accept the lyrics. You cannot always press Enter as with some dialog boxes, since Enter is used
in editing the lyrics. With the keyboard, you can also use the tab key to select the OK button to
avoid conflicts with the lyric text.
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Tips for entering lyrics:

���� Each syllable of a word should be separated with a hyphen if you want the syllables spread across
notes.

���� A space is used to separate words across notes.

���� If you have notes that you do not want any lyrics assigned to, use the underscore ( _ ) in the lyric
editor for each note. You can also select the notes that you do not want to have lyrics, press
Alt+Enter, and under the Notes tab, set Lyric Syllable to Never.

���� For more advanced information on lyrics go to the Help menu and search on "Lyrics Command."
Also, see the chapter on Lyrics on page 64 of this User’s Guide.

Last Additions (Text Entry)
You may have noticed in the jingle.nwc file there is other text in the score besides lyrics. This text will not
alter the play back by NoteWorthy Composer, but would be helpful to a piano or guitar player if you printed
your notation of “Jingle Bells” and asked them to play it. If you have the jingle.nwc file open, you will see
the word Lively . This sets the mood of the piece for the piano player. You will also see an F being used as
a chord symbol.

To enter the text “Lively:”

1. Place the insertion point between the clef and the key signature.

2. Select the Insert menu and Text or press the X key.

3. Type Lively  in for Expression.

4. Set the Display Font to Staff Bold.

5. Under Placement, set Staff Position to 13 and do not Preserve Width. (If you do not have a
Placement tab showing, go to Tools: Options, Editor tab, uncheck Smart Properties Insert).

6. Click OK .

You should see Lively  at the top of the score with a little diamond or anchor (Tools: Options, Editor tab,
Small Expression Anchor) beside it. Since you did not Preserve Width, the diamond (or anchor) appears so
you will have something to select when you need to edit (Alt+Enter) the text. The diamond (or anchor) will
not show in your printed copy.

Follow the same process to enter the chord symbols in the song. The Staff Position for the chord symbols is
8.
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Printing “Jingle Bells”
Now that your notation is complete, you may want to print it. To print, you first need to make sure that the
correct printer is selected. This is done with File: Printer Setup. Set Name to be the printer you want to
use for printing. You can also check the paper size and orientation here.

Once you have the correct printer, you can focus on what you want to print and how you want it to look.
The following selections are under File: Page Setup.

•••• Contents tab - Check the staves that you want to print.

•••• Fonts tab - Set the font size and style for lyrics and other text. Use the defaults for now.

•••• Options tab - Set details of your song; such as, notation size, measure numbers, whether to print
the title and/or staff labels. If you have questions about the settings, click the ? button and click on
the item.

•••• Margins tab - Set the margins measured from the edge of the paper.

•••• Preview tab - Preview your song before printing. If you do not like the format, go back to the
Margins tab and Options tab and make changes accordingly.

Once you like what you see in Print Preview and you are ready to print , do one of the following:

� Select the File menu option and Print .

� Click the Print  icon.

� Press Ctrl+P .

If you will use the same print settings for most of your songs, you may want to create a Print template. You
can also edit the existing templates with your print margins and other settings.

Congratulations!
You have completed the entire song: notes, lyrics and all. Your final notation should look just like the file
jingle.nwc. Hopefully, you now have a good idea how NoteWorthy Composer works.
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Chapter 1
Getting Started with NoteWorthy Composer

About NoteWorthy Composer

NoteWorthy Composer Version 2 is a software music composition and notation processor for Windows. It
allows you to create, record, edit, print and play back your own musical scores. With the software, you can:

Create Your Own Songs
Write your own songs, or transcribe existing songs, using the notation editor. The editor allows you to
create notation in a manner similar to writing a document in a word processor. Add parts (staves), notes,
text, lyrics and symbols directly from the editor. A note palette is available for visually setting most note
attributes, with optional keyboard shortcuts for note entry using only the computer keyboard. An
Undo/Redo feature allows you to reverse up to 100 of your most recent changes.

Listen to Your Songs
Songs can be played back via your computer's sound card, or to external MIDI setups. Notes are
highlighted as they are played, so you can follow along while the computer plays back your creation.

Record Your Performance
You can use an external MIDI keyboard for real-time and step-time entry of your music. Use the record
button to record a new performance while the current song is played, and then polish it in the notation
editor. For step-time input, you can interactively input your notes remotely from a MIDI keyboard while
editing a score.

Print Your Songs
Print your whole score for a conductor's view, or just the parts that you select. You can specify the notation
size, in points, for fitting various arrangements on the page. Arrangements can be previewed prior to
printing.

Import and Export Standard MIDI File Format
Use the interactive Import Wizard to load an existing performance that is contained in a standard MIDI file
(*.mid). The performance will automatically be converted to notation, which you can then listen to, edit,
rearrange and polish. Standard MIDI files can be exported, which can be shared with others who need
*.mid file format.

Transpose Parts into Other Keys
A transpose feature can be used to transpose parts from one key to another. Notes and key signatures are
automatically updated to the new key. Support is included for instruments that are not tuned to concert C
(A440) tuning via a second, audio only transpose mechanism.

Publish Your Songs on the Internet
NoteWorthy Composer Viewer is an application that will display and play back *.nwc song files. This free
product will allow you to share your NoteWorthy Composer song files  (*.nwc) with your friends, family
and fans.
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About the User’s Guide

This user’s guide is designed to cover the basics of NoteWorthy Composer Version 2 and will help you
create scores like a pro in no time.

It is assumed you have a working knowledge of the Windows interface. If you do not feel comfortable with
Windows, you may want to review the Windows help file, documentation and/or tutorial.

In this user’s guide, the left mouse button is considered the primary (most often used) button. If your mouse
is set up differently, please be aware of this fact.

Learning More about NoteWorthy Composer

If you choose, each time you open NoteWorthy Composer, a Did You Know? dialog box will appear
providing a new user tip. To turn on this feature, go to Help: Did you know… and click the Show on
startup box.

Another way to learn the capabilities of NoteWorthy Composer is to use the sample song files. These songs
are in the Samples folder and can be accessed with File: Open Sample. By playing, previewing and printing
the files, you can get an overview of the product. If you see a symbol in a sample score that interests you,
select (highlight) it and press Alt+Enter to open the dialog box for the symbol. Once the dialog box is open,
specific help can be accessed by clicking the “?” at the top right and then clicking an item in the dialog box
for more information.

Following the Step-by-Step Tutorial “Notating Jingle Bells” at the start of this manual will take you
through starting a song from scratch using some of the most common commands. This is a great way to get
up to speed on how note and symbol entry work.

Lastly, if you have Internet access, our web site has areas that are helpful in learning and using the product.
In addition to FAQ and other product information, there is also an online community site (forum) for users
to post questions and comments for other users to read and issue responses. The address is
http://noteworthysoftware.com
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Chapter 2
The Work Space
This chapter will cover the toolbars and editor display.

Toolbars

There are 5 standard toolbars in NoteWorthy Composer. They are File, Insert , Notes, Notehead and
Piano. The toolbars provide quick access for many of the commands and settings that are in the menus.
With View: Toolbars… they can be added to, moved and changed. You can also create your own toolbars.

Dockable toolbars
In the image above, you will notice the toolbars in a different location than usual. You can click and drag
the toolbars to the best position for you. Just click one end of a toolbar with the left mouse button and drag
it. If you drag it to one side of your work space, the toolbar will align vertically with the side. You can drag
them to the middle. You can change the long bar to a block by hovering over one side, getting the 2 arrow
image and then left clicking and dragging.

Tip:  If you drag the toolbars off the screen and cannot get them back, go to View: Toolbars…,
Customize…, Restore Defaults.
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Setting Toolbars to View
To select the toolbars that will show on your screen, select View: Toolbars… and check the toolbars you
want to show.

Customizable toolbars
NoteWorthy Composer will allow you to streamline your toolbars to only include commands that you
frequently use. With View: Toolbars…, Customize…, you can add a new toolbar, remove an existing
toolbar, change the name of an existing toolbar, add a new command to an existing toolbar, rearrange the
commands included in a toolbar and reset the toolbars to the factory default.

Step-by-Step: How to customize the toolbars
The toolbars in NoteWorthy Composer can be customized to show only the icons you want in
the number of toolbars you want. You can edit the existing toolbars or create your own. Here
are several examples of working with toolbars.

This example adds the View Zoom icon to the File toolbar after the View Zoom Out icon.

1. Select View: Toolbars.
2. Click Customize.
3. Under Toolbar in the top left, select File.
4. Under Available Tools, scroll down to the end to View Zoom and double click it to put it in the Active

Tools Window.
5. Find View Zoom in the Active Tools Window and click it.
6. Press Up or Down button to move it under View Zoom Out in the List
7. Click Close.
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This example shows how to delete icons from the Notes toolbar.
1. Select View: Toolbars and click Customize.
2. Under Toolbar in the top left, select Notes.
3. In the Active Tools window, double click any icons you want to remove.
4. Click Close.

To create your own toolbar:
1. Select View: Toolbars and click Customize.
2. Click New.
3. The title Custom 1 will appear for Toolbar. If you would like to change this name, click Rename..
4. Under Available Tools, double click the icons you want in your toolbar.
5. Click Close.

Piano Keyboard Toolbar
You can choose if you want the piano toolbar showing or not with View: Toolbars, Piano – check to show
or uncheck to not show on work space. Like the other toolbars, you can click and drag the piano around –
just click on the double lines on the left of the bar to move it from the starting location.

• Middle C on the keyboard is marked with a small horizontal line on the piano bar.
• The location of the insertion point on the staff is marked with a circle on the piano bar.

To change the size and number of keys of the piano, use View: Toolbars, Piano Style: Here you will see a
large selection to fit your computer screen size and your composing needs.  The “All Keys” selections
include all the keys supported by NoteWorthy Composer. However, the Standard 88 selections are the keys
available on standard piano.  If there is a need for the keys to wrap, this is done in the lower octaves.

What can I do with this piano bar?
Following are some of the ways you can use the piano bar for note entry and play back.

Locating the insertion point: The location of the insertion point on the staff is marked with a
circle on the piano bar. As you move the insertion point on the staff, this will also show on the
piano bar. If you press the Enter key on the computer keyboard, a note will be placed at this
position.

For note entry: Left mouse clicking on the piano keys will enter a note on the staff using the
duration already selected (the position of the insertion point is irrelevant). To add a rest, left mouse
click the rest icon on the piano bar or press the Space Bar. Bar lines will be added as you go based
on the time signature (only when entering notes from piano bar).

To add a chord:
1. Left mouse click and hold the first note of the chord
2. Right mouse click the notes remaining in the chord – one at a time – while

continuing to hold the left mouse button.
3. Release the left mouse click
4. The chord will appear on the staff

For play back: As the song is played back, the notes will highlight in red on the piano bar.
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Note: Not every command and option has a toolbar icon. For example, you will find 5
commonly used time signatures on the Insert Toolbar. However, by going to Insert: Time
Signature, you can select the value you want for the Time Signature.

At the same time, there are some toolbar icons that are quick keys (fast insert) and do not have a
keyboard shortcut or menu command. Here is a table of those….

Treble Clef ¾ time sig Alla Breve Pedal Down

Bass Clef 4/4 time sig Common Time Pedal Up

Alto Clef 6/8 time sig

Percussion Clef

fff mp Fermata

ff p Caesura

ff pp Breath Mark

mf ppp

Status Bar
At the bottom of the workspace is a Status Bar. This can be turned on or off with View: Status Bar.

On the left, the File icon can be used to start a new song, open a song file, arrange the open song files or
close all the files. The *.nwc song files that you have open are listed across the bottom. Just click on the file
name to bring that file to the front – or make active.

Indications are made beside the file name. Some examples: If you have made changes to a file without
saving, an * will appear beside the file name. If the file is not an original *.nwc file, there will be an
indication in parentheses as to the source. For example, (mid) for an imported *.mid file. If the file is
playing, the play icon will show.

Starting on the far right, the MIDI Channel Number, Group Name and Staff Name of the active staff are
listed. A right mouse click to this information will open the list of staves to allow you to change the active
staff. To the left of the staff information is the clef, current measure count and bar number at the insertion
point of the active staff.

Score Editor Display

When you are working in the editor with a score, the staff (or staves) will extend to the right as if following
a time axis. When you print your song, the staff (or staves) will be wrapped in sheet music style. For
example, to see all of the file jingle.nwc you must scroll to the right. However, go to File: Print Preview
and you will see the staves wrapped in several lines for printing.
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The scroll bars can be used to move around in the current view of the score. As you move rightward, you
are advancing further into the song. If you have more staves than will fit in the display, the vertical scroll
bar will move up and down through the staves.

The active staff in the editor includes a flashing cursor, which is known as the insertion point. The insertion
point can be moved around the staff using the arrow keys on the computer keyboard, or by clicking the left
mouse button at the desired position. This insertion point indicates where the next item added to the staff
will be placed. In most cases, both the vertical and horizontal position of the insertion point is important in
determining the position of the next item. In some cases, however, the vertical position of the insertion
point is not significant. Clefs, time signatures, key signatures, and bar lines are examples of items that are
placed at fixed vertical positions within the staff, regardless of the position of the insertion point. The
setting for the insertion point having a crosshair (the dotted vertical and horizontal lines) is set with View:
Show Crosshair.

Display Size
To change the size of the notation in the display window, use View: Zoom In (make larger), View: Zoom
Out (make smaller) or View: Zoom… (to set the pixel size). This will not change the printed notation size
which is done with File: Page Setup, Fonts.

Staves and Items Shown
The staves shown in the work space are the staves that will be printed when you use the Print command.
Thus, to select the staves to show in the score editor, use File: Page Setup, Contents tab.

If you are using Staff Layering, to turn layering on or off, use View: Layering in Edit Mode. Make sure
you have the global setting at File: Page Setup, Contents, Allow Layering turned on to be able to layer
and unlayer.

The command View: Viewer Mode (quick key F11) will hide the items that will not be printed
(Preserve Width markers, hidden notes, mpc controllers, etc) and layer the staves (if used).

Staff Label Panel
For an open song file, the area to the left is the Staff Label Panel. This can be turned on and off with View:
Staff Label Panel. The color for the panel can be set with Tools: Options, Color Tab, Staff Label Panel.

When the Panel is on….

• The Staff Label will be shown for each staff (set with Staff: Staff Properties, General tab, Staff
Label) – if this is not on, right click in the panel and select Show Labels.

• When the mouse hovers to the left of the staff, a tool tip will appear with the Staff Label (set with
Staff: Staff Properties, General tab, Staff Name). When the insertion point is away from the start
of a staff, a mouse hover to the left of the staff will show Staff Name, Bar Number, Clef and Time
Signature.

• Left mouse click in the Panel will make that staff the Active Staff.

• Double left mouse click will select the entire staff.

• Right mouse clicking in the Panel will give options of Show Labels, Bracket/Brace/Layer with
Next Staff and Staff Properties.
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Bar Number Panel
For an open song file, the area to the top is the Bar Number Panel. This can be turned on and off with
View: Bar Number Panel.

Color
You have control over the color of the printer default, staff label panel, editor background, active
background, active staff, inactive staff, active hidden notation, inactive hidden notation, play highlight and
7 highlight colors. To access the global color settings, go to Tools: Options, Color tab.

The highlight colors are accessed when you select a note, rest or other item and want to assign a color to
it. For example, to set a note to a highlight color, select a note, press Alt+Enter and under the Visibility tab,
set Item Color to one of the highlights. To set the entire staff (the lines) to a certain color, with nothing
selected, press Alt+Enter, Visual tab, Color - select.

The highlight colors can also be accessed from the Color Toolbar for selected items and items you are
going to enter. If you cannot see that toolbar, go to View: Toolbars, Color – check the box. For quick
access to the colors, use the back slash (\).

Coloring Notes vs Noteheads – how and why?
Just the notehead can be colored (leaving the stem the printer default color – or a different color) or the
entire note can be colored (note and stem). One example is for handbells. You may want to color different
notes in a chord leaving the stem a base color.

Just notehead: If you select a color from toolbar before placing the note, just the notehead will be colored
as the notes are entered. Another way to color just the notehead would be to select (highlight) a note, go to
Edit: Properties [Alt+Enter], Notes tab, Notehead Color.

Entire Note: If you select (highlight) a note, and choose a color from the toolbar, the entire note will be
colored (same as setting Edit: Properties [Alt+Enter], Visibility tab, Item Color).

Keys to Setting Color
• Be careful not to set your staff color to be the same as your background color, or you
will not see the staff.
• If you get a mess of colors, you can always click Restore Defaults to return to the
original settings.
• Use colors as a teaching aid or as a reminder of a difficult part for performers.

Editor Functions
Overall functions used in editing are set with Tools: Options, Editor tab. Following is a list of settings
available.

Rt Mouse Sets Insertion Pt
When this box is checked, using the right mouse button on the staff will place the insertion point at that
location on the staff and open the Note Command dialog box. When this box is not checked, the right
mouse button will open the Note Command dialog box and will not reposition the insertion point.

Ignore Transpose on MIDI In
This checkbox controls how incoming MIDI events are converted into notes when the currently active staff
is using an instrument with transposition. If disabled, incoming MIDI notes will be added to the staff
exactly as they sound on the staff. For example, in order to add a C4 note into a Bb trumpet staff, you
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would need to press the Bb3 key on the piano, since the trumpet triggers a two semitone transposition to its
Bb tuning. When enabled, you can enter notes onto the staff from the piano keyboard, or a remote MIDI
device, and the notes will be placed onto the staff without applying the transposition settings of the current
instrument. This means that you can enter a C4 note onto the staff by pressing the C4 key on the piano,
even if the current instrument is a Bb trumpet (with a transposition of -2).

Smart Insertion Point
The insertion point will align to the right side of notes and rests when this option is checked. When not
checked, the insertion point aligns along the transparent vertical grid that aligns all notes and rests in the
current score.

Custom Expression Anchor
This option changes the editor's expression anchor into a custom pointer that indicates the justification
origin. The size option indicates the proportion of space reserved for the custom anchor relative to the
current zoom level. A size setting of about 1.0 is recommended when using the custom anchor.

Chase Playing Notes
When this box is checked, play back will follow along the score highlighting the notes (and lyrics if
present). However, there are 2 cases where you may want to un-check this box. First, when you disable
note chase, you can edit the song while it is playing back. The changes will not effect play back until you
stop play and start it again. Second, if play back along with the activity of the display is a strain on your
computer system, disabling the note chase may make play back more accurate since there are less demands
on your system

Smart Properties Insert
If you will be entering many of the same text items and want them quickly entered at the same position,
then you would want to have Smart Properties Insert checked. For example, if you used Insert: Text to add
“lively” at the top of the staff. The next time on the staff that you add “lively” it would be added at the
same position with the same properties. Whereas, if you did not have this checked, “lively’ would be added
where your insertion point rested.

Extra Margin Staff Spacing
This setting is for the display editor only. It does not effect how the printed score will look. This can be
adjusted if you have items at the very top of the staff that may be difficult to see.

Undo Levels
The levels available to Undo with Edit: Undo while working in the editor.

Shortcuts to Using NoteWorthy Composer

Most note and symbol entry in NoteWorthy Composer can be done from the computer keyboard with quick
keys. There is a list of quick keys in the Help menu under Keyboard Reference and in the Appendix of
this guide (page 87). Once you learn the shortcuts, notating will be faster than using the menus and the
mouse.

NoteWorthy Composer uses many of the same editing keyboard shortcuts as word processors. If you are not
familiar with these shortcuts, the instructions below will be helpful. You may want to practice these
techniques on one of the sample songs provided with NoteWorthy Composer.
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Moving Around in a Staff
To move the insertion point one item at a time, use the ←←←←→→→→    keys. To move one measure at a time, use
Ctrl+←←←←→→→→. . . . While working in a staff, pressing the Home key will take you to the beginning of the staff and
the End key will take you to the end of the staff. When you add Shift to the key combinations, the items
will be selected as you move.

Edit: Goto… will place the insertion point at the start of the measure of the active staff for the measure
number that you enter. The quick key is Ctrl+G.

Edit: Find  and Edit: Find Next  will find a given item on the active staff based on an Expression or
Category. See the section on Find Command  (page 11) for more details.

Selecting
Some actions in NoteWorthy Composer can only be performed after items have been selected. For example,
cut (Ctrl+X) and beam (Ctrl+B) cannot be executed until items are selected. Once an item is selected, it
will appear highlighted with a different background color. To select an item(s):

Mouse selecting - Click the left mouse button and drag over the item.

Keyboard selecting - Place your insertion point to the left (or right) of the item, hold down the Shift key
while pressing the →→→→ (or ←←←←) key to highlight the item. Holding the Ctrl  key at the same time will select the
entire measure. Shift+End selects to the end. Shift+Home selects to the start.

Deleting
An item can be deleted by placing the insertion point to the left of the item and pressing Delete or by
placing the insertion point to the right of the item and pressing Backspace.

Moving Around in the Score
Pressing Page Up will activate the staff above the currently active staff. The insertion point will be moved
to the new active staff. Page Down will activate the staff below the currently active staff. Ctrl+Home  will
activate the top staff while Ctrl+End  will activate the last staff.

Keyboard Shortcuts for Commands
Most note and symbol entry in NoteWorthy Composer can be done from the computer keyboard with quick
keys. There is a list of quick keys in the Help menu under Keyboard Reference. There is also a printable
sheet in the Appendix

Some commands can be accessed with the right mouse click. You can simply be on a staff and right click to
access the commands – Note, Rest, Chord Member, Bar Line, Paste, Select All, MIDI Control, Notation,
Staff Properties or Select an item and right click for a list of commands available for that item.

To access properties for an item, select it and press Alt+Enter.

Undo and Redo

The Edit: Undo  command reverses the effect of the most recent staff editor command or action.
For example, if you delete a staff and then decide you did not want to do that, you can use Edit:
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Undo Delete Staff. If you transpose and decide you transposed by the wrong amount, you can reverse the
transpose with Edit: Undo Transpose Staff.

You can undo more than one action by repeatedly selecting this command. The quick key is Ctrl+Z .

The number of commands that can be undone can be configured with Tools: Options, Editor, Undo Level.

The Edit: Redo command (quick key Ctrl+Y ) can be used to re-apply a command that was
reversed using the Undo command. This command is only available immediately after an Undo

operation has been performed. If a subsequent change is made to the active staff after an Undo command is
performed, the Redo command will no longer be available.

Cut, Copy and Paste

The standard commands of Cut, Copy and Paste are supported in NoteWorthy Composer. You can
copy or cut a section of notes, rests and/or symbols and paste it at another point in that staff,
another staff in the song or in another song file that you have open. These commands are found in

the Edit Menu. The quick keys are Cut – Ctrl+X, Copy – Ctrl+C, Paste – Ctrl+V.

Find Command
The command Edit: Find  (quick key Ctrl+F ) can be used to search on an Expression or a Category of
entries such as Dynamics, Flow Direction, etc. Once you have found the first item, you can continue
through the staff finding more of those items by pressing F3 (Edit: Find Next ).

Find by Expression

This find method can be used to find almost anything on a staff, one item at a time. For simple text find
operations, simply type in the text you want to find and the text in the active staff will be compared with
the text you entered. You can place an asterisk (*) in your string and it will act as a wildcard character,
matching anything in that position of the text.

For example, if you wanted to find the places you had used Insert: Text to enter E7, check By Expression
and enter E7 in the box. Press Enter or click OK. The first occurrence of text entry E7 would be selected. If
you need to edit that entry, press Alt+Enter. Make the change and click OK. Use F3 to find the next
occurrence of text entry E7.
Advanced: Every object on the staff has a character representation, and you can use an advanced find to
locate an item by its character representation. For the more advanced find operation, start the expression
with a vertical bar (|) followed by the text label that represents the object you are trying to find.

Examples:

|Dur:*8th
This search will find anything on the staff that has an 8th note as its duration.

|Note|Dur:8th
This search will find any note on the staff that has an 8th note as its duration. It will not find chords
or rests with this duration.

|Tempo|*Tempo:120|
This search will find the next tempo on the staff set to 120.

|Text|*Slowly
This search will find the next text expression on the staff that includes the text Slowly .
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|Bar|*|SysBreak:Y|
This search will find a bar line in the active staff that specifies a system break.

|Clef|*
This search will find the next clef on the staff.

The key to finding items on a staff is that each item on the staff has a text representation.
You can see a staff item's text representation by selecting any one item on a staff and using
Edit:Copy. To see the text representation, you can either start a new find (Ctrl+F) and paste
into the expression box, or open a notepad window and paste into it. This only works with
single item selections. You can simply replace any part of the text description that you do
not want to match with an asterisk (*).

Find by Category

This find method has a set of predefined find algorithms which can be used to search for objects in the
staff.  Some items include Tempo, Dynamic and Clef Data. Once you have selected a type item to search
for, you can use F3 to continue to search for that type item in the staff.

Filtered Properties
The command Edit: Filtered Properties… (quick key Ctrl+F3 ) can be used to edit a group of items all at
once. For example, if you needed to change all text expressions from one word to another or, if you wanted
to change the color of all the barlines at one time. The command uses the same character representations
the Find command uses (examples shown above).

Examples:

Change same text to a different same text – if you had used Insert: Text to place the name “Joseph”
along the staff and now you decided “Mary” should do those parts,

1. With the insertion point at the start of the staff, press Shift+End to select the entire staff.
2. Go to Edit: Filtered Properties… (or quick key Ctrl+F3)
3. At Enter matching text, type in Joseph – click Next
4. In the Expression field, type in Mary – click OK

All places with Joseph will be changed to Mary.

Change all quarter rests to be a color –

1. With the insertion point at the start of the staff, press Shift+End to select the entire staff.
2. Go to Edit: Filtered Properties… (or quick key Ctrl+F3)
3. At Enter matching text, type in |Rest|Dur:4th – click Next
4. Under the Visibility tab, set Item Color – click OK

All the quarter rests will be changed to the color you set.
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Command Menu

Across the top of the NoteWorthy Composer work space, you will see the command menu as shown above.
When you select one of the menu headings by left clicking it with the mouse or using the quick key, the list

of commands for that heading will appear. The quick key for each
heading is Alt+the underlined letter. For example, Alt+F will open the
File Menu, as shown to the left.

From there, you can select the command by left clicking on it or using the
quick key. For example, to access Print Preview, the underlined letter V is
the quick key. So pressing V will access Print Preview.

If there is a quick key for the command, it is listed to the right. For
example, for File: New, instead of using the menu, you can press Ctrl+N.

If the action cannot be performed, the item will be grayed out. Some
commands require a song file to be open, items to be selected or play to
be stopped before they can be accessed.

If you do not see the underlines, your operating system requires you to
press the Alt key first before the underlines will be visible. You can
change this default setting under the Operating System’s Display
Properties, Appearance tab, Effects, uncheck Hide underlined letters for
keyboard navigation until you press the Alt key, then Apply.

All commands followed by three dots (...) utilize a dialog box to designate
parameters associated with the item to be added.

The Appendix includes command summary tables with the command,
icon and quick key (if applicable) and short function description.
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Chapter 3
Working with Files

NoteWorthy Composer will open NoteWorthy Composer song files (*.nwc) with File: Open and
will import Standard MIDI files (*.mid) with File: Open or File: Import .

When you select File: Open, the file types displayed in the box will depend on the selection in "Files of
type:" If you have NWC Files selected, only songs with the *.nwc file extension will be shown. If you have
Midi Files selected, only songs with the *.mid file extension will be shown. Lastly, if you have Song files
selected, both types will be shown. Keep this setting in mind if you want to open a file and cannot see it in
the list - you may just need to show that file type.

You can also drag and drop *.nwc files and *.mid files onto the application to open them.

NoteWorthy Composer will save files as NoteWorthy Composer song files (*.nwc) with File: Save
or File: Save As and will export the notation as a Standard MIDI files (*.mid) with File: Export.

To have fast access to the folders related to your NoteWorthy Composer work, you can set the folders that
are accessed with Tools: Options, Folders.

*.nwc File Format

With File: Open, if you select a *.nwc file, it is opened right away as this is NoteWorthy Composer's native
file format. When you save a file, it will be saved as a *.nwc file, unless you change the “Save as Type”
setting.

When you install NoteWorthy Composer, the associations are set that when you double click a *.nwc file in
an Windows Explorer Window, it will open in NoteWorthy Composer.

If you want to send a *.nwc file to someone, they will need to have NoteWorthy Composer or NoteWorthy
Composer Viewer to be able to open the *.nwc song file.

Backup Files
You have the option of creating a backup file (*.bak) of your *.nwc song file when you save the *.nwc file.
The backup file could be used if the original *.nwc file became corrupted or lost.  To have backup files
created, in Tools: Options, File, check Backup files during save. The location where backup files will be
saved is set with Tools: Options, Folders, Backup Files.

Multiple backup files can be created as you work, in case you need to go back to an earlier saved version.
To the right of Backup files during save, select a number for Queue size for extra backups The back up
files will be named filename.nwc.bak, filename.q1.nwc.bak, filename.q2.nwc.bak, etc.

To open a *.nwc.bak file, from NoteWorthy Composer, go to File: Open Backup…
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Auto Save Files
If you often forget to save your song files as you work on them, you can set NoteWorthy Composer to
automatically saves *.nwc song files as you work on them. To invoke Auto Save, go to Tools: Options,
File, check Auto save/recovery. You can set the frequency of saves in minutes. You can also set a warning
to alert you of unsaved files when you close the program.

*.mid File Format

The MIDI file format (*.mid) is a standard that is used by many other players and sound applications.

What is MIDI?  MIDI stands for Musical Instrument Digital Interface. It can be used to refer to the
protocol, the interface and the file format. It was developed as a standard so musical instruments could talk
to each other and so musical instruments could talk to computers.

The protocol sends messages for note on, note off, and how hard a note is struck or played (note velocity).
Because it is a representation of note sequences depicting a live performance, a MIDI file is different from
a sampled audio file that actually records a digital representation of the physical sound. Thus, a MIDI file is
much smaller than a sampled audio file. A MIDI file is also not based on visual notation, but on the note
and other events that depict the performance.

Importing
If you select to open or import a *.mid file, by default, the MIDI Import Wizard will be started. This is
because NoteWorthy Composer will need to convert the MIDI "performance" saved as a Standard MIDI file
into the visual notation used by NoteWorthy Composer.

Step 1 of the MIDI Import Wizard
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Notate Pedal Marks: When opening a MIDI file, the program can convert sustain pedal events directly
into standard music notation. This option enables this conversion. In many cases, it is desirable to disable
the automatic inclusion of this data, since it can detract from the overall visual quality of the final score.

Insert Instrument Changes: When opening a MIDI file, the program is capable of embedding sound
patch changes into the final notation data. The first sound patch encountered in a track is automatically
placed into the track data associated with the track performance information. This option enables all patch
changes found in a track to be opened and included in the final music notation.

Automatic Beam: When opening a MIDI file, the program will automatically beam any adjacent notes
smaller than a quarter note that appear in the same beat of a measure. If you wish to do the note beaming
manually, you can disable this option.

Detect Compound Time: When opening a MIDI file, the program will automatically detect compound
time signatures in a MIDI sequence when this option is enabled. When disabled, any time signatures
encountered in the sequence are assumed to be simple time. This influences how the musical beat in a score
is emphasized when converting note events into notation. For example, when this option is enabled, a
sequence in 9/4 time will use a dotted half note as the beat when the beaming function is performed. If the
option is disabled, that same sequence would use a quarter note as the beat when the beaming function is
executed.

Note Resolution: The note resolution value specified here influences how note events in the sequence are
converted into music notation. Smaller note values allow more complex sequences to be notated correctly.
Larger note values tend to simplify the resulting notation, but may not adequately represent the original
musical sequence.

Rest Resolution: The rest resolution option can be used to control the overall placement of rests within the
score. Larger note values here will result in fewer rests being placed in the imported score. Smaller rests
may still be used in order to preserve the sequence of note on events, but smaller rests will not be used to
create staccato effects.

Step 2 of the MIDI Import Wizard
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Map each MIDI channel to a new staff: This option is used to control whether each MIDI channel found
in a MIDI track will be mapped into a new staff. When set, a new staff will be created for note events
occurring in each MIDI channel that is present. When not set, all note events will be treated together in the
conversion to a notated staff regardless of their MIDI channel.

Maximum single track chord size: This option is used to enable automatic splitting of MIDI tracks into
two staves. The value in this box is semitones. Whenever a group of simultaneous note events span a
semitone interval larger than this value, the performance will automatically be split into two staves during
import.

Step 3 of the MIDI Import Wizard

Here the individual tracks of the *.mid file can be edited. Select the track that you want to edit and select
Edit for the Import Instruction Dialog box.

In the Import Instruction, you can set the Range that will be imported into the staff. Notes above or below
this range will be ignored. The ranges are listed as MIDI note pitches, which are a combination of note
name followed by the octave.

The Channels to be imported into the staff can be set. All channels that are marked will be imported
together into the new staff. All channels that are not marked will be ignored.

The overall Notate Options set in Step 1 of the MIDI Import Wizard can be set for the individual staff at
this point.
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Step 4 of the Import Wizard

Simply click Finish to import the file based on your settings.
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The results of an imported *.mid file
The import process is a file conversion of a MIDI "performance" into "graphical" or "visual" notation used
by NoteWorthy Composer.

Trying the import with different settings will change the results. Some key things to adjust are the Note and
Rest Resolution. If want a different staff break out, then you may want to adjust the Maximum single track
chord size.

Note: Also see What is imported when a MIDI file has lyrics? on page 67.

Skipping the Import Wizard
If you import similar *.mid files and are comfortable with default settings for the import, you can skip the
import wizard. In Tools: Options, File tab, do not check Use Import Wizard on Open. When this is not
checked, the File: Open and File: Import command will simply open the file using the default options
specified in the Import tab of Tools: Options.

Exporting
To convert your notation to a *.mid file, when you select File: Export, the file type of the song will need to
be set in “Save as type:” You have the option of Type 1 MIDI File or Type 0 MIDI File.

When exporting to a *.mid file, should I use Type 1 or Type 0?
This question is better answered for the receiving software. However, select Type 1 if the receiving
software will accept it (most do).

What is different between a Type 1 MIDI file and Type 0?
File Type 0 puts all the information in a single track. File Type 1 maps each staff to a separate track in the
MIDI file.

Advanced Options for Exporting
 For advanced options in exporting to a MIDI file, see Tools: Options, File tab -

Export per track signature - When saving to a Type 1 MIDI file, this checkbox is used to control
whether Save places key and time signatures in the track or staff where they exist as well as the
conductor track. Some applications complain if they detect signature data in a track other than the
conductor track.

Header Info - When saving to a MIDI file, this box is used to control whether the MIDI file will
include such items as song title and author information. Some commercial MIDI and notation
applications have trouble handling this kind of information when it is present in the conductor track
of a MIDI file. It sometimes causes the program to assume that there is not a conductor track in the
file. With this box, you can configure this in one of three ways:

Exclude: Disables all of this kind of information in a MIDI file
Track 0:  Places this information in the conductor track
Track 1:  Places this information in the first sequenced track after the conductor track (only
applies to the Type 1 category of standard MIDI Files, Type 0 files will not contain this
information)

Step-by-Step: How to Combine tracks of a MIDI file
When using File: Open or File: Import in NoteWorthy Composer to import a *.mid file, the number of
staves created is based on the number of tracks in the *.mid file. There may be a case when you would like
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to reduce this to one track so you will have one staff in your NoteWorthy Composer song file. Here is a
method you can use that will bring you very close to that goal.

1. Import the *.mid file with File: Open or File: Import.
2. Use File: Export and set Save as type: Type 0 MIDI File to export the file as a Type 0.
File Type 0 puts everything on one track, while File Type 1 keeps separate tracks.
3. Import the file. Do not check "Map each MIDI channel to a new staff” and set “Max
single track chord size" very high, like 100.
4. All information should now be on one staff.

You may lose some information importing, exporting and importing again, but it may be worth it to you.

Sharing Files

NoteWorthy Composer Viewer is an application that will display and play back *.nwc song files. This will
allow you to share your NoteWorthy Composer song files  (*.nwc) with your friends, family and fans.

Templates

NoteWorthy Composer comes with some templates and you can create your own. When you select File:
New, the Song Templates dialog box will be presented. The selections available when you first install
NoteWorthy Composer are those from the factory. You can edit these templates to your liking and/or create
your own templates.

Some reasons why you may want to create or edit your own templates include:

• Set default print and font selections
• Set default author name and copyright information
• Create a template with the number of staves, staff labels, instruments, etc. for your frequent

applications
• Create a template with the rhythm or metronome beat that you like for recording from MIDI keyboard

Once you open a template with File: New to start a song, you can edit it and save it without altering the
original template.

Create Templates
When you open a new song file in NoteWorthy Composer, you are presented with the Song Templates
dialog box. Some templates are provided for you, such as the Piano template that opens with two staves
connected with the piano brace. Several methods for creating your own templates are listed below.

Step-by-Step: How to edit and save the sample templ ates as new templates
1. Open the template that you want to change.
2. Change the features as you wish (it may be as simple as you want the tempo slower and
you select the diamond beside the tempo and press Ctrl+ E to edit it).
3. Select File: Save As.
4. Save file under the Template folder as a name you choose.
5. Now when you enter Ctrl+N, your template will be in the Templates dialog box.
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Step-by-Step: How to create a template from the beg inning
1. Create your song file that will be a template.
2. Select File: Save As.
3. Save file under the Template folder as a name you choose.
4. Now when you enter Ctrl+N, you template will be the Templates dialog box.

Step-by-Step: How to drag and drop files to templat es
1. Press Ctrl+N to access the Song Templates dialog box and click the tab heading that you
want your template to be placed under.
2. Locate the file template you created, or a song file that you want to be a template, on an
Explorer window or the File Manager.
3. Drag and drop the file you created onto the Song Templates dialog box. To drag and drop
-- In the Explorer window or File Manager, left click the file you created and continue to hold
down the left mouse button. Then, drag the file over the top of the Song Templates box and
release the left mouse button.

Template Tabs
You can also create your own tabs in the Song Templates dialog box by adding folders inside the Template
folder.

Will it destroy a song template to save it as my song?
When you use File: New and select a template, this is now your song file. You can notate in this file and
save it (File: Save or Save As) as your song file. This will not remove or over-write the template. The
template will remain unchanged. You can use File: Open directly on a template file to make changes to a
template and then save those changes. If you create a new song file with the same name as one of the
templates and save it, the template will be destroyed.

Advanced: When you select File: New, the default is the Template folder in the NoteWorthy Composer
program folder. If you want to change this, use Tools: Options, Folders, Modify New File Templates.

Downloading *.nwc files

There are many *.nwc files available for download on the Internet. Just entering “nwc files” in a search
engine will bring up a lot of sites.

Moving a song to other applications

If you are writing a paper on music or putting together a music test, you may want to insert parts of staves
or songs from NoteWorthy Composer into another application. For example, the staff sections in this
manual and the printed song “Jingle Bells” were first created in NoteWorthy Composer and then inserted
into a word processor.

Step-by-Step: How to move your song page to another  application
The following provides details on copying an entire song, as the Jingle Bells song in the Tutorial Section.

1. Create and save the staff or song that you want to move to another application.

2. With the file open, select File: Print Preview.

3. Click the Copy button.
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4. Select clipboard or file (*.emf - Enhanced Windows Metafile format).

5. Next, paste (Ctrl+V ) to your other application.

Tips for variables to change in Page Setup and Print for better performance:

���� Printer: The higher the printer resolution, the larger the file, which requires more RAM for using
the file. For example, if the printer is set for your laser printer and the bitmap cannot be created,
select your fax software.

���� Staff size: If you will be placing the staff in a smaller area, selecting a smaller font size in
NoteWorthy Composer should give better results.

���� Margins: If you only want the staff to take up 4 inches in width by two inches in height in the other
application, go ahead and set those margins in NoteWorthy Composer.

Step-by-Step: How to copy a staff section for use i n another application
The staff sections in the “Notating Jingle Bells” section of the user’s guide were created with Edit: Copy
Special. This command copies the selected staff area and places it in the Windows clipboard.

1. Select (highlight) the section of the staff you want to copy.

2. Select Edit: Copy Special.

3. If you only have one staff, the section has been copied to the Windows clipboard. If
you have more than one staff, you will be asked if you want to copy only the active staff or
copy all staves.

4. Go to your other application and press Ctrl+V  to paste the staff/staves.

Tips for different looks when using Copy Special:

���� In File: Page Setup, toggle Increase note spacing for larger note durations for more or less space
between notes.

���� Use Insert: Text to insert spaces around areas you will copy. For example, if you want to copy the
clef on the staff but not the starting bar line, insert spaces after the bar line. Then select only the
clef to be copied.

���� If your printer or application will not print some of the staff once you have pasted it to the
application, try making the active staff color black (Tools: Options, Editor tab).

Advanced: If you create a Microsoft Word file with NWC info pasted into it and open it on a computer
without the NWC font installed, it will not work. You will need to embed the font into the document.

All applications cannot be covered, but for an example, in Microsoft Word, you can go to Tools: Options,
Save and click Embed True Type Fonts when you create the file. Word may not recognize that you have a
True Type Font in the metafile that you paste. So, you may have to enter 1 NWC font character on the page
(it can be hidden) to make Word Recognize it. You would do this by selecting the NWC font and entering a
character.
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Chapter 4
Play Back
NoteWorthy Composer uses MIDI sound for play back. Your sound card or other play back device, and
your Windows system, must be configured for MIDI, whether by you, or an installer provided with your
card.

Configuring for Sound

Sound cards support a variety of sound generation methods. For starters, the audio out from a CD player
may be run through the amplifier in your sound card to generate sound. In addition, almost all sound cards
include a digital audio section that works with audio samples, such as *.WAV files. Neither of these sound
types are MIDI sound. Your card, and your Windows system, must be configured for MIDI, whether by
you, or an installer provided with your card.

To see if play back is working on your system:

1. Open NoteWorthy Composer
2. Select File: Open Sample…
3. Select jingle.nwc
4. Click Open
5. Go to Tools: Play

If you hear sound, you are set up for MIDI play back.

If you do not hear sound:

Make sure that the MIDI Mapper is the ONLY device selected for Devices used by play back in Tools:
Options, MIDI. You may have several devices listed but it will be best to start with just the MIDI Mapper.
If it does not work, try another device available under Devices Available for Play under Devices Used by
Play. Try the devices one at a time. Only have one device listed under Devices Used by Play back when
testing.

Make sure you do not have other sound applications open that may hold the sound card and not let other
application use it.

Verify that the volume for MIDI is turned up, either on the speaker or, more likely, the Windows Master
Volume mixer panel. You can also access the Windows Volume Control from within NoteWorthy
Composer with Tools: Windows Volume Control.

You can test to see if MIDI is supported by your system by doing the following:

1. Open the Windows Media Player program
2. Open the "CANYON.MID" file, which comes with Windows and should be in your \WINDOWS

directory (or \Windows\Media or \WINNT\Media or the like depending on your version of
Windows).

3. Press the play button

If no sound is heard, or some other problem prevented play back, then MIDI is not properly setup on your
system, or it is not supported. If sound is heard, then NoteWorthy Composer should be able to play back
files on your system.
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If it failed, you may need to re-install the software that came with your sound card. If this does not work,
you may have a IRQ or DMA conflict in your system. Most sound cards provide a diagnostic utility that
can help you solve problems like this. Please refer to your sound card's instructions for additional details.

If it succeeded, then you are probably playing back songs within NWC that use channels not supported by
your card. If you play the song nowell.nwc, you should be able to hear something, even in this situation.

Play back Sound and Instruments

The play back sound and instruments available are a function of your sound card or other play back device.

You will get better sound if you have a Wave Table sound card versus an FM Synth card. A wave table
card uses samples from actual instruments for play whereas the FM card uses a series of mathematical sin
functions, etc. to make an instrument sound. So the wave table card is going to sound more like the real
thing. Some cards will support both. Perhaps your sound card is now set on FM and you could change it to
Wave Table.

One last thing to remember, if your speakers are very inexpensive, you may not be able to hear how good
your sound card is.

Step-by-Step: How to Change instrument in staff for  play back
During play back, to hear different instruments play certain sections of a staff, you can use an instrument
patch.

1. If you will only have one instrument playing the entire staff, or to set up the first instrument to be
played in the staff, select Staff: Staff Properties or press F2.

2. Click the Instrument tab. For Name, click Predefined Instruments…, select the
instrument you want for play back and click OK. Click OK.
3. After entering your notes, place the insertion point in the staff where you want the first
instrument to stop playing and a different instrument to start.
4. Select Insert: Instrument Change or press the quick key I. On the Instrument tab, under
Name, select the instrument you want to start playing at this point instead of the previously
selected instrument. Click OK. Click OK.

5. The instrument name will appear to mark on the staff where the instrument change takes place. (The
name will not appear on your printed copies – unless you change the setting under the Visibility tab.)

6. You may add additional instrument changes by following the same process.

For more information on selecting instruments, see the Staff Properties, Instrument tab on page 37.

Channels

What is the relationship between a staff and MIDI channel?
Each staff that you add to a NoteWorthy Composer song file must be assigned to a MIDI channel. When
you start a new song, by default, the first staff of a song is assigned to MIDI Channel 1, the second staff is
assigned to MIDI Channel 2, third staff to MIDI Channel 3, and so on.

Each MIDI device can support up to 16 MIDI channels. Each MIDI channel can only handle one
instrument patch at a time. So, each unique instrument patch will need to be mapped to a different channel.
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Sharing a MIDI channel
If you have more than one NWC staff that will use the same instrument, all of them can probably share the
same MIDI channel. For example, if you have three staves that require a Violin instrument (Staff: Staff
Properties, Instrument tab, Name: Violin), all three can probably be mapped to the same MIDI channel
(Staff: Staff Properties, MIDI tab, Channel) with acceptable results. In this case, only the first staff
should actually assign an instrument, since a MIDI channel is only capable of sounding one instrument at a
time (although it can probably play multiple pitches at the same time).

In addition, the volume for all three staves must be the same in this configuration, since each staff is
sharing the same MIDI channel. If you need independent volume control in each staff, this technique will
not work. In this case, you should assign each staff to different, unique MIDI channels.

Reviewing your MIDI channel assignments
The Tools: Score Review command is an easy way to quickly review your MIDI channel assignments.
When the Device and Channel columns are the same for two or more staves, then they are sharing a MIDI
channel. In this case, only one staff should have a Patch assignment, and the others should show "---" in
this column.

When things don't sound right
If you assign 2 staves with different instruments that are sharing the same MIDI channel, only one of the
instruments will actually be played for both staves. So if you ever have a staff play back with a different
instrument than you have assigned, check the staff to channel mappings.

Most sound cards have a percussion channel on Channel 10 (some have it on Channel 16). This channel
will only play back percussion sounds and cannot be used for general instrument patches (the instrument
patch command is often used to select different drum kits when sent on MIDI channel 10). The sample file
drumref.nwc demonstrates the different pitches mapping to different percussion sounds for this channel.

When you have more than 15 staff parts
If you have a score with more than 15 parts, your primary option is to share MIDI channels using the
technique described above. However, if you have more than one MIDI device in your system, an advanced
option is to use more than one play back device to increase your number of available MIDI channels. This
is configured from Tools: Options, MIDI tab, Devices used by play back, and then can be utilized in a
staff using the Staff: Staff Properties, Midi, Play back device control. You should only try this if you are
comfortable with this advanced technique, and are not planning to share your files with others that are not
employing this technique.

Percussion Channel

Most sound cards and MIDI play back devices have a percussion channel on channel 10 (or 16).

The sample file drumref.nwc (found in the Samples folder and printed below) shows that different pitches
represent different percussion sounds. You will need to determine if your sound card supports this.  Open
the file drumref.nwc and play back. If you hear percussion sounds, then Channel 10 is your percussion
channel. If you do not hear percussion sounds, change the Channel to 16 (Staff: Staff Properties, MIDI tab,
Channel) and try play back again. If you hear percussion sounds, then Channel 16 is your percussion
channel. If you do not, your play back device may not support MIDI percussion play back.
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General MIDI Percussion Reference
NoteWorthy Software, Inc.

Copyright © 2004 by NoteWorthy Software, Inc.
All Rights Reserved

Ride Cymbal 2 High Bongo Low Bongo Mute High Conga

a
G =200

D e k e k d k e k

Acoustic Bass Drum Bass Drum 1 Side Stick Acoustic Snare

b D e k e k d k e k

Open High Conga Low Conga High Timbale Low Timbale

a f k e k e k d k

Hand Clap Electric Snare Low Floor Tom Closed High Hat

b f k e k e k d k

High Agogo Low Agogo Cabasa Maracas

a e k d k e k f k

High Floor Tom Pedal High Hat Low Tom Open High Hat

b e k d k e k f k

Short Whistle Long Whistle Short Guiro Long Guiro

a e k e k d k e k

Low Mid Tom High Mid Tom Crash Cymbal 1 High Tom

b e k e k d k e k

Claves High Wood Block Low Wood Block Mute Cuica

a dk e k e k d k

Ride Cymbal 1 Chinese Cymbal Ride Bell Tambourine

b f k e k e k d k

Open Cuica Mute Triangle Open Triangle

a
e k d k e k n

Splash Cymbal Cowbell Crash Cymbal 2 Vibraslap

b
e k d k e k f k
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General MIDI Drum List  - The table below shows the notation from the page before in another format.

Note Pitch Percussion Sound Note Pitch Percussion Sound
B2 Acoustic Bass Drum B4 Ride Cymbal 2
C3 Bass Drum 1 C5 High Bongo
Db3 Side Stick Db5 Low Bongo
D3 Acoustic Snare D5 Mute High Conga
Eb3 Hand Clap Eb5 Open High Conga
E3 Electric Snare E5 Low Conga
F3 Low Floor Tom F5 High Timbale
F#3 Closed High Hat F#5 Low Timbale
G3 High Floor Tom G5 High Agogo
G#3 Pedal High Hat G#5 Low Agogo
A3 Low Tom A5 Cabasa
Bb3 Open High Hat Bb5 Maracas
B3 Low-Mid Tom B5 Short Whistle
C4 High-Mid Tom C6 Long Whistle
Db4 Crash Cymbal 1 Db6 Short Guiro
D4 High Tom D6 Long Guiro
Eb4 Ride Cymbal 1 Eb6 Claves
E4 Chinese Cymbal E6 High Wood Block
F4 Ride Bell F6 Low Wood Block
F#4 Tambourine F#6 Mute Cuica
G4 Splash Cymbal G6 Open Cuica
G#4 Cowbell G#6 Mute Triangle
A4 Crash Cymbal 2 A6 Open Triangle
Bb4 Vibraslap

The following staff section shows how a few of the percussion sounds would be notated for play back:

Clap Bell Bongo Triangle
Hand Cow Low Mute

b f k C4      

d k
a dk C6      

d k  
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Understanding the Difference Between Percussion Sounds and Percussion
Notation
The percussion channel on a sound card will play back drum sounds (bass drum, hand clip, cow bell, etc.)
based on the note pitch. For example, to notate the Bass Drum sound,

Played on MIDI Channel 10 as “Bass Drum 1”

Percussion notation often assigns a drum type to a certain position on the staff. For example on a 5 line
staff, the bottom space will be a Bass Drum. However, at playback, the following would play as a Low
Tom.

Played on MIDI Channel 10 as “Low Floor Tom”

You may want to create a visual staff for printing that is muted and display and hidden staff for play back
that is assigned to channel 10.

Visual staff for printing, will be muted

Hidden Staff for play back, will not be visible
(File: Page Setup, Contents)

Other Play Back Devices

Play back over keyboard

To have NoteWorthy Composer play back over a MIDI Keyboard, make sure you have the correct device
for access to your keyboard selected in Tools: Options, MIDI, Devices Used by play back. It should be the
only device selected. It may be named external something or mpu something.

If you do not have the device needed as a selection, then this is not supported on your system or has not
been installed correctly or at all.

] k

b dk
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Multiple Play Back Devices

In Staff: Staff Properties, MIDI tab, the Play back Device is selected by device name.

The devices are set in Tools: Options, MIDI tab, Devices Used by play back.

You can review the staves and what device is used for play back in Tools: Score Review, Device.

Common Questions Regarding Play Back

Do I always have to start play back from the beginning?
Pressing F5 or Tools: Play will start play back. However, you can set where you want play to begin each
time. Select Tools: Options and click on the MIDI tab. Under Play Options, you can select play to start
from the beginning, from the current measure, from the insertion point or from several other choices.

How can I play back only one staff of my song?
If you only want one staff to play back, make the staff active and press Shift+F5 to play the active staff. If
you want some staves to play and some not to play, use Tools: Mute List for quick access to setting the
staves to mute or not mute.

After transposing, how do I get the correct play back?
This behavior is controlled by the "Update staff play back transposition" checkbox in the Transpose dialog.
When checked, the results after the transpose will sound at the same pitch, even though you transposed. If
you did not mean to leave this checked, you can reverse the effect by going into Staff Properties (F2), the
Midi Tab, and changing the Transposition field to "+0" (example), rather than the "+3" (example) that it
was changed to after the Tools, Transpose command was used.

How do I have notes sounded as they are placed using the computer keyboard?
Tools: Options, MIDI, Play Options, Play notes on entry. When this is checked notes will sound as they are
placed using the computer keyboard.

Can the playback start be paused a few seconds while I get ready to practice with the song?
You can set the number of seconds to delay the start of play of a song from 0 to 60 under Tools: Options,
MIDI, Play Options, Start Countdown.
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Chapter 5
Working with Staves

When you want to create a new song in NoteWorthy Composer, use the command File: New.

There you will be presented with the Song Templates dialog box. You can select <Blank Score> which is a
blank single staff, one of the other provided templates or a template you have created. Click OK.

After you have selected the template, you will see the File: Info dialog box.

Enter in the information as is appropriate for your song. You can edit this information later with the
command File: Info.
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Adding and Deleting Staves
All songs must have one staff. Staves can be added and deleted as you like.

Staff: New Staff will add a staff to the current song at the bottom of the system. This staff will
become the active staff.

Staff: Delete Staff will delete the active staff. If you delete it in error, or decide you did not want to
delete it, you can immediately use Edit: Undo Delete Staff.

Active staff
In NoteWorthy Composer, only one staff is active at a time. While active, notes can be added to the staff,
the staff can be deleted, moved, have properties changed and the like. To make a staff active, click on the
staff.  The active staff will have

• The insertion point flashing on the staff.  (also a crosshair if turned on – set in View menu)
• A vertical bar in the Staff Label Panel on the left side of the work space.
• The active staff color (Tools: Options, Color, Active Staff).
• The active background color (Tools: Options, Color, Active Background).
• Boundary edges if you have View: Active Staff Edges on.

To change which staff is active, you can click on a staff or use the quick keys. Page Up and Page Down
will move one staff at a time. Ctrl+Home will make the top staff the active staff. Ctrl+End will make the
bottom staff the active staff.

Moving Staves
If you would like to change the order of the staves in a song, they can be moved. Click the staff that you
want to move to make it active, then go to the Staff menu and select

Move Staff – This command will open a box with the staff names. You will click on the staff that you want
the active staff to be place above.  Click OK.

Move Staff Up – This command will move the active staff up one staff. The quick key is Ctrl+Shift+Page
Up

Move Staff Down - This command will move the active staff down one staff. The quick key is
Ctrl+Shift+Page Down
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Staff Properties
Each staff will have its own Properties. The properties can be accessed with Staff: Staff Properties or the
quick key F2. The first tab in the dialog box is the General tab. Here you can set Staff: Name.

General Tab

Staff Name
This is the name that you
give to the staff. Each
staff must have a unique
name. You will see this
name listed in Tools:
Score Review and File:
Page Setup, Contents.

Staff Label
This label will be used in
printing – File: Page
Setup, Options, Staff

Labels and for editor display in the Staff Label Panel (View: Show Label Panel). These names can be
duplicated in a song. When adding a label for a Grand Staff, add the label for the top staff and leave it
blank for the lower staff.

Abbreviated
The Abbreviated label will be used in all systems after the first. If the Abbreviated label is empty, the Staff
Label will be used for all systems.

Group
If you would like to assign your related staves to different groups, use this field. You may want to have
groups for horns and strings; melody and rhythm; standard and hidden; or other groupings. The groups will
be listed in File: Page Setup, Contents for easy selection of printing and showing on the display. See the
Step-by-Step: How to use groups on page 32.

Ending Bar
The final bar line on the staff is set with this field. You can select Section Close, Master Repeat Close,
Single, Double, Open (hidden).

Step-by-Step: How to use groups
Groups allow you to break the score into sections. For example, if you have a repetitive
drum beat in your score that has one measure repeated many times, you may not want it to
show during editing and play. In this case, the drum staff could be a different group than
your melody. If you want to practice with NoteWorthy Composer while looking only at your
vocals or your instrument, put the other parts in a group so you can hear them, but not see
them.

1. Make the staff you want to put in a separate group active by clicking it or using the Page Up/Page
Down keys to reach it.

2. Select Staff: Staff Properties (F2). Click the General tab. For Group, enter the name of the group
under which this staff will be sectioned. For example, if you have a rhythm staff, you could name
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the group “Rhythm.” (You may have many staves in one group or many groups with one stave
each, but a staff can only be in one group.)

3. Use File: Page Setup, Contents to select which group(s) will be shown in the work space.

There are two song files in the Samples directory in which groups are used. Nowell.nwc was created with
two groups to use as a test for sound cards. The notation in each group is the same. However, in the play
channels are different. This allows a user to see the song in a logical fashion and provides test results in
determining if a sound card’s play back is channel specific.

Moonlite.nwc also has two groups, one for play back and one for display/print. The reason for this is visual
ornaments were created with Insert: Text for the display group (named Standard) and then the ornaments
were notated in the play back group (named Hidden). The play back (Hidden) group would not be shown
on in the workspace or printed. The display (Standard) group would be muted to hear the play back group.
See measure 30 for an example.

An easy way to get an overview of these files is Tools: Score Review. This dialog box lists all the staves.
To see all the groups in the work space, use File: Page Setup, Contents tab.

Step-by-Step: How to select the ending bar line sty le
1. Click the staff to make it active.
2. Press F2 for Staff Properties.
3. Under the General tab, make the selection under Ending Bar.

How do I label staves as flute, trumpet, etc?
Staff labels are created with Staff Properties (F2). Under the General tab, under Staff Label, enter the label.
In File: Page Setup, Options tab, you have the choice of which staves to print the staff labels with, if at all.

Visual Tab

Boundary Size
To increase or decrease the
area around a staff, you can
set the Upper and the Lower
space by number of note
positions. You may want to
increase the Upper to have
more room for Text, tempo,
etc. You may want to
increase the Lower to have
more room for lyrics. These
same settings are also
accessible via the Edit Lyrics
command. The vertical size
is automatically increased
when adding lyric lines.

Staff Lines
The number of lines in a staff can be set from 0 to 32. Generally, this will be set to 5. However, you may
want to change it to 1 for a percussion staff or to the number of strings on your banjo or guitar if you want
to print out some blank staff paper to work with.
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Color
To change the color of the staff, select from default or 1 of the 7 highlight colors. The default and highlight
colors are assigned with Tools: Options, Color tab.

System Connections to Next Staff
These items can also be set by right clicking in the Staff Label Panel.

• Orchestral Bracket – the brace style at the start of the staff will have a straight heavy vertical bar
connection

• Grand Staff Brace - the brace style at the start of the staff will be a curly brace (like for piano). See
the Piano template as an example (File: New, General tab, Piano).

• Bars Connected – the bar lines between the staves will be connected
• Layer with Next Staff - If you are using Staff Layering to include 2 voices on a staff or other reasons,

check this box to layer the staff with the staff below it when layering is turned on. Make sure you have
the global setting at File: Page Setup, Contents, Allow Layering turned on to be able to layer and
unlayer. Section the section on Staff Layering (page 50) for more details.

Step-by-Step: How to change the number of lines in a staff
When you add a new staff (Staff: New Staff), the default number of lines in the staff is 5.
However, if you would like to change that default:
1. For the active staff, go to Staff: Staff Properties (or press F2).
2. Under the Visual tab, in the Lines field, set the number for the staff.

Step-by-Step: How to increase space around a staff
On occasion, you may have notes that go off the top of the staff or move into the staff below.
There is any easy way to add more space around your staves.
1. Press F2 to open the Staff Properties dialog box for the staff.
2. Under the Visual tab, increase the numbers for Upper and/or Lower Boundary. Increasing
the Upper number will provide more space above the staff and increasing the Lower number
will provide more space below the staff.

How do I select how I want the staves to be connected?
To connect your staves in an orchestral fashion or with a brace (as for piano), go to Staff Properties (F2) for
each staff. Under the Visual tab, select Orchestral Bracket or Grand Staff Brace.

Where can I view a summary of the staves?
Select Tools: Score Review (quick key R) to see a list of staves. Information about the staves includes
whether it is muted, device and channel assignment, patch and transposition.

How do I select what staves to show in the work space?
The staves shown in the work space are the staves that will be printed when you use the Print command.
Thus, to select the staves to show in the work space, use File: Page Setup, Contents tab.

How do I  print certain staves of a song?
In File: Page Setup, Contents tab you may check the staves and/or groups you want to print.



Chapter 6 – Note Attributes and Symbols   35

Midi Tab

Part Volume
The initial volume of the staff’s MIDI
channel is set here. The range is 0 to 127
with 127 being the loudest and the default
setting. If you would like the volume of the
channel to be set by the play back device,
set the volume to –1 and no volume settings
will be sent to the MIDI device.

Stereo Pan
For the initial stereo position, the range is 0

to 127 with 64 being the center position and the default setting. A setting of –1 will send no stereo
information to the MIDI device. Not all MIDI devices respond to this setting. If you are not getting a
response to the setting, check your MIDI device capabilities.

Muted
Check this box if you would like the staff to be muted (no sound) during play back. Even if the staff is
muted, tempo marks, instrument patch changes, and volume changes will still be included in the play back,
in case another staff uses the same channel, and depends on the settings from this staff. Whether a staff is
muted or not can also be controlled by Tools: Mute List and the Mute Staff icon.

Play back device
The Play back device for the staff is selected by Device name.

The play back devices are set in Tools: Options, MIDI tab, Devices Used by play back.

You can review the staves and what device is used for play back in Tools: Score Review, Port.

Channel
Set the MIDI channel on the play back device that the staff will use. MIDI devices can support up to 16
channels. By default, each staff is assigned a new channel.

Keys to understanding Staff versus MIDI Channel

What is the relationship between staff and MIDI channel?
Each staff that you add to a NoteWorthy Composer song file must be assigned to a MIDI
channel. When you start a new song, by default, the first staff of a song is assigned to MIDI
Channel 1, the second staff is assigned to MIDI Channel 2, third staff to MIDI Channel 3, and
so on.

Each MIDI device can support up to 16 MIDI channels. Each MIDI channel can only handle
one instrument patch at a time. So, each unique instrument patch will need to be mapped to a different
channel.

Sharing a MIDI channel
If you have more than one NWC staff that will use the same instrument, all of them can probably share the
same MIDI channel. For example, if you have three staves that require a Violin instrument (Staff: Staff
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Properties, Instrument tab, Patch: Violin), all three can probably be mapped to the same MIDI channel
(Staff: Staff Properties, MIDI tab, Channel) with acceptable results. In this case, only the first staff should
actually assign an instrument, since a MIDI channel is only capable of sounding one instrument at a time
(although it can probably play multiple pitches at the same time).

In addition, the volume for all three staves must be the same in this configuration, since each staff is
sharing the same MIDI channel. If you need independent volume control in each staff, this technique will
not work. In this case, you should assign each staff to different, unique MIDI channels.

Reviewing your MIDI channel assignments
The Tools: Score Review command is an easy way to quickly review your MIDI channel assignments.
When the Port and Channel columns are the same for two or more staves, then they are sharing a MIDI
channel. In this case, only one staff should have a Patch assignment, and the others should show "---" in
this column.

When things don't sound right
If you assign 2 staves with different instruments that are sharing the same MIDI channel, only one of the
instruments will actually be played for both staves. So if you ever have a staff play back with a different
instrument than you have assigned, check the staff to channel mappings.

Most sound cards have a percussion channel on Channel 10 (some have it on Channel 16). This channel
will only play back percussion sounds and cannot be used for general instrument patches (the instrument
patch command is often used to select different drum kits when sent on MIDI channel 10). The sample file
drumref.nwc demonstrates the different pitches mapping to different percussion sounds for this channel.

When you have more than 15 staff parts
If you have a score with more than 15 parts, your primary option is to share MIDI channels using the
technique described above. However, if you have more than one MIDI device in your system, an advanced
option is to use more than one play back device to increase your number of available MIDI channels. This
is configured from Tools: Options, MIDI tab, Devices used by play back, and then can be utilized in a staff
using the Staff: Staff Properties, Midi, Play back device control. You should only try this if you are
comfortable with this advanced technique, and are not planning to share your files with others that are not
employing this technique.
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Instrument Tab

Name – Predefined Instruments
On the Instrument tab, the instrument used for play back of the staff is selected under Name. To select an

instrument, click Predefined
Instruments. The default
Instrument Tree will appear which
is based on General MIDI. To see
more options under a heading, such
as Piano, click the + icon. Once
you find the instrument that you
want, select it and press OK or
double click the instrument. This
instrument will now appear in the
Name field of the Instrument tab
and be the play back instrument for
the staff.

Advanced: You can create your
own instrument trees based on the
equipment that you have
(keyboards, synths, etc). New
Instrument Tree files are added to a
dedicated folder that is controlled
from Tools: Options, Folders.

To learn more about creating your
own instrument trees, open the
Sample.nwcitree file in a text

editor. This file is located on your computer where you have installed the program under NoteWorthy
Composer 2\itrees.

Other instrument trees created by other users are available in the online community.
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MIDI Patch Instructions
If you have a MIDI synthesizer that you want to send patch information to, use these fields.

Send Patch - Select the Send Patch box if you want to select a specific MIDI patch number that will be
sent to the MIDI synthesizer. The patch number starts at 0, and goes up to 127 (it is zero based). If you
have an external synthesizer that displays patch numbers, these might start at 1 (it is one based), so you
might have to subtract one from the number on the display when used here.

The easiest way to select a patch number is by using the Predefined instruments button. You can then select
the instrument by name, rather than number.

Note: If the current staff is sharing a MIDI channel with another staff, then only one of the staves should
send patch number information.

Send Bank Select - MIDI synthesizers will often support a variety of instrument banks , each containing
different groups of instrument sounds. Select the Send box to specify a specific bank of sounds. The MSB
field specifies the value for MIDI Controller 0, and the LSB field specifies the value for MIDI Controller
32.

These controller values will then be sent to your synthesizer. Consult your synthesizer manual if you think
it supports multiple patch banks and you want to use this feature.

Note: If the current staff is sharing a MIDI channel with another staff, then only one of the staves should
send bank select information.

Default Dynamic Velocities
The default velocities (how hard a note is struck, how hard a horn is blown, etc) used with Insert: Dynamic
are set here for the instrument selected under Name. Here the dynamics are listed from softest to loudest.

Selection at
Insert: Dynamic,  Style

Notated As/
Listed on Instrument tab

Pianissimo (ppp) ppp
Pianissimo pp
Piano p
Mezzo Piano mp
Mezzo Forte mf
Forte f
Fortissimo ff
Fortissimo fff

Transposition
If this instrument is based on a real world instrument, you can use this setting to make the notes play back
in the same pitch as the real world instrument. For example, if the staff is notated for a trumpet in Bb, you
would enter a value of -2 in this box.

This play back transposition is also controlled by the "Update staff play back transposition" checkbox in the
Tools: Transpose Staff dialog. When checked, the results after the transpose will sound at the same pitch,
even though you transposed.
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Score Review
To review all the staves at once, use Tools: Score Review. For each staff, you can see the Name, Partition,
Mute Status, Port, Channel, Patch Number and Play back Transposition in tabular form. You can access
Staff Properties from Score Review.

The Score Review is not only a summary of the song’s staves, but also helpful in troubleshooting sound
problems. Following is a list of the fields in Score Review and how they can help:

Name: In general, this will show how many staves are in a song, even if some are layered or hidden. This
may help with other people’s files, if they refer to staves by name instead of position, you can quickly see
where the staff is located. It could also help you to keep your staves in order if you are working on an
Orchestral Piece. These items are both set on the General tab of Staff Properties.

Mute:  This field provides a quick check to see if you have muted a staff and did not intend to leave it
muted. Y = muted and N = not muted. This can be set on the MIDI tab of Staff Properties, Tools: Mute List
or the Mute Staff icon.

Device: The device correlates to the Play back device setting on the MIDI tab of Staff Properties. These
then correlate to the Devices used by play back set in Tools: Options, MIDI. How this would help in
trouble shooting is, if you received a file and a staff was not sounding (and it was not muted), it may be that
they had that staff assigned to a device that you do not have a play back device assigned to.

Channel: MIDI devices can support up to 16 channels. Each channel can only handle one instrument patch
at a time. If you wonder why the violin is sounding like a flute instead, it may be that you have both staves
assigned to the same channel. You need to change the channel for one staff. Or, if your trumpet staff is
making percussion sounds, you can check and find that it is assigned to the percussion channel (10 or 16).
Similarly, volume and other performance parameters can only be controlled by one channel. So even if you
have 2 piano staves assigned to the same channel, which would normally be OK, if you want a different
volume for one staff, they will need to be on different channel. Channel is set with Staff: Staff Properties,
MIDI, Channel. For more on channels, see page 24.

Patch: Knowing the patch can help you review what instruments you have assigned; as well as, verify
proper channel alignment (as discussed above).

Trans: If you have a staff that is sounding at a different pitch than it is notated, the Transposition field can
help. Transposition is controlled by the "Update staff play back transposition" checkbox in the Transpose
dialog. When checked, the results after the transpose will sound at the same pitch, even though you
transposed. If you did not mean to leave this checked, you can reverse the effect by going into Staff
Properties (F2), the Instrument Tab, and changing the Transposition field to "+0" (example), rather than the
"+3" (example) that it was changed to after the Tools: Transpose command was used.

Vol:  The volume of the staff – set with Staff: Staff Properties, MIDI tab

Pan: The stereo pan of the staff – set with Staff: Staff Properties, MIDI tab

From Score Review, if you need to edit any of the fields, click the Goto Staff Properties… and you will be
taken to the Staff Properties Dialog box. After making the changes and clicking OK, you will be brought
back to the Score Review dialog box.
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Staff Tools
There are several tools that apply to an entire staff. When you invoke these commands the entire staff will
be affected. If you have items on a staff selected, these tools will not be available. These items are all found
under the Tools menu.

Automatic Beam
This command can be used to automatically beam a series of adjacent notes that contain stem flags and also
fall inside of a beat.  For example, if you have a staff with 4/4 time signature, eighth notes will be beamed
in groups of 2. This command does not alter any notes that are already beamed.

Transpose Staff
Transposing a staff is the process of notating the staff in a different key than the key for which it was first
written. If you are playing piano from a printed score and a friend with a B Flat trumpet joins you in
playing the literal score, it will sound horrible. This is because when the trumpet plays a C note, it will
actually sound as a note with a pitch of B flat. Since you used NoteWorthy Composer for your score, you
can quickly transpose the piano score for the trumpet player and provide a print out. The trumpet player
will need a piece transposed up 2 semitones from the piano piece, since it is two steps up from B flat to C.

Note: Make sure that you have a key signature on the staff! If the staff is in the key of C, it may not have a
key signature. You need to add one if it is not there. You can do this using Insert: Key Signature.

To transpose a staff:

1. Select Tools: Transpose Staff.
2. Select the number of semitones (up or
down) by which you would like to transpose the
staff. Click OK. The notes on the staff should
change to reflect the new pitch and key signature.

For proper play back pitch by the computer after the
transposition, enable the Update staff play back
transposition option. This will automatically
compensate the MIDI play back pitch by the
opposite number of semitones. this play back
transposition/compensation selection can later be
altered manually in Staff Properties (F2) under the
MIDI tab.

Why is this necessary?
This is necessary because computers/synthesizers generally play all notes at the written pitch, regardless of
the selected instrument patch. If you want your computer to mimic the behavior of a real instrument, you
sometimes have to set the staff's play back transposition in order to mimic the real world instrument. An
actual real world B flat trumpet playing a notated middle C will actually sound a B flat note. However, your
computer sound card/synthesizer assigned with Instrument set for Trumpet will play a notated middle C as
a middle C. You have to adjust the staff play back in order to get it to sound as a real trumpet should sound.
Cleaning up after transposing
You may want to Audit Note Stems (Tools menu) after a transpose to reset notes stems to logical
directions.
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More on Transposing

Look at the first staff on the left - "Piano part in C Major"

• If a Piano plays this note, it will sound like a C
• If a B flat Trumpet  plays this note, it will sound like a B Flat (B flat up to C = 2 semitones)
• If an A Clarinet  plays this note, it will sound as an A (A up to C = 3 semitones)

To change the notation of the Piano part in C Major  for use by a Bb Trumpet, the C note must be re-
written as an D in order to get a C sound. Also, the key signature has to change from C Major to D Major.
Using the Tools: Transpose Staff command, you simply transpose by +2 semitones to convert the part.

To change the notation of the Piano part in C Major  for use by an A Clarinet, the C note must be re-
written as an E flat in order to get a C sound. Also, the key signature has to change from C Major to E flat
Major. Using the Tools: Transpose Staff command, you simply transpose by +3 semitones to convert the
part.

Tips:

• When composing a new piece, write your parts for piano first. Then, you can simply transpose
parts as necessary for the target instrument.

• If your target instrument sounds lower than the tonal center of the target instrument for the
existing notation, then you must transpose upward. This means you would use a positive number
for transposing. The reverse is also true.

• You will find other tips on transposing in the online community.

Force Accidentals
This command will force accidentals on all notes on the staff that do not have an accidental. This will be
based on the key signature. Naturals will be assigned with this command.

This command could be used when learning which notes are affected by the key signature. It is also used in
the Key Change Procedure.

Audit Bar Lines
Based on the time signature of the active staff, when this command is used, the bar line placement will
remove bar lines that are not in the correct place and insert bar lines at the proper place.

During the audit, if a note starts before a new bar line and ends after the new bar line, this will become a
tied note. If you do not want this type correction, you can

1. Use Audit Bar Lines to see where the problem measures are
2. Use the Undo Command (Ctrl+Z) to remove the ties and new bar lines placed by the audit
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3. Make your corrections to note count in measures as you see fit

NoteWorthy Composer only supports one voice on a single staff. The smaller duration in a chord is what
will be used in the measure count for auditing the bar lines.

This command will abort if it finds that a bar line is needed in the middle of a triplet grouping or a split
stem chord. If this occurs, you can manually insert a new bar line at the point where the audit aborted, and
then re-initiate the audit to complete the job.

Audit Accidentals
This command can be used to remove any unnecessary accidentals assigned to notes in the active staff. It
compares all notes with the running key signature, and if the accidental it contains matches the running
signature, then the accidental is removed.

This audit will not detect if the accidental is the enharmonic version of a note that appears in the key
signature.

Audit Enharmonic Spelling
A# is the enharmonic spelling of Bb. The notes are the same pitch but written a different way on the staff.

The Audit Enharmonic Spelling command is used to audit the note spelling on the staff. All note pitches,
including individual members of a chord, will be compared to the note pitches contained within the key
signature. If a note pitch can be spelled within the key signature, then the audit will change the spelling of
the note such that it is in the key signature. If the note requires an accidental, the spelling of the note will
favor sharps for key signatures that contain sharps, or flats for key signatures that contain flats.

In some chord scenarios where multiple adjacent intervals of a minor second are used, the result of the
audit may include some lost or inaccurate notes in the staff. In cases where this might happen, you are
warned, and the chords that may have a problem are shown to you, one by one. The specific things that
might cause trouble include:

1. Intervals of a minor second where one or more of the notes in the interval are tied to some other
note in the staff which is not a part of the same minor second interval. The note tie may not be
correct after transposition, as they may get transposed to different staff positions and accidental
assignments.

2. A group of 3 or more notes that are all separated by intervals of a minor second. In this case, one
or more of the notes may no longer exist after the transposition.

3. Two overlapping notes combined into a chord.

If any of these situations apply to the staff you are transposing, you should look over the chords as they are
shown, and then decide whether you still wish to use the audit function. In any case, if you are unhappy
with the results of the audit, you can simply undo it afterwards to restore the staff to its form prior to the
audit.

Audit Note Stems
This command is used to audit the note and rest stem directions assigned in the currently active staff. It will
remove unnecessary stem up or down attributes and recalculate stem directions for note beams and triplets.
This command is useful after transposing a staff into another key and you want the stem directions to be
cleaned up to reflect the note's new positions on the staff.
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Chapter 6
Note Attributes and Symbols
This chapter will cover entering notes, rests and the attributes associated with notes and notation symbols.
Many of the icons shown are on the tool bars. If you do not see the icons, you may not have the tool bars
turned on. See page 3 for more about showing the tool bars and icons.

Entering Notes and Rests

Basically, notes/rests are entered on a staff by selecting the duration icon, setting the cursor on the pitch
and pressing Enter/Space Bar. See the Tutorial Note Entry for more details.  The key points to know are:

Notes are entered by pressing the enter key.

Rests are entered by pressing the space bar.

Notes can also be entered with the piano bar. See the toolbar section for more details on page 5.

Note: For a multi-measure rest, the command is Insert: Multi-measure Rest (page 61).

Noteheads
There are various note heads supported in NoteWorthy Composer: Standard, X, Harmonic (Open
Diamond), Blank Space (stem with no note head), Non-pitched, Diamond, Shape Notes. The icons are
shown with View: Toolbars…., Notehead.

By default the Standard notehead will be selected in NoteWorthy Composer until you select a different style
notehead. You can select the notehead by selecting the icon or choosing the menu command, Notes:
Noteheads.

Each notehead can be assigned any of the durations supported in NoteWorthy Composer.

Durations
The durations supported, icons shown from left to right below, are whole, half, quarter, eighth (8th),
sixteenth (16th), thirty-second (32nd) and sixty-fourth (64th).

Durations for the notes and rests are set by clicking the icon or selecting the command Notes: Durations.
There are also quick keys for selecting the durations.

Duration Quick Key
Whole 1
Half 2
Quarter 3
Eighth 4
Sixteenth 5
Thirty-second 6
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If you are interested in other names for the durations:

American English Medieval
Whole Semibreve Semibrevis
Half Minim Minima
Quarter Crotchet Semiminima
Eighth Quaver Fusa
Sixteenth Semiquaver Semifusa
Thirty-second Demisemiquaver --
Sixty-fourth Hemidemisemiquaver --

Note Attributes

These are things that can be added to notes or done to notes.

Accidentals
The accidentals supported are Natural, Flat, Sharp, Double Sharp, Double Flat

To assign an accidental to a note, you can do it when you enter the note or edit the note later to have an
accidental.

Step-by-Step: How to enter an Accidental with a Not e
1. Select the note duration (with the mouse, quick key or menu selection)

2. Select the accidental (with the mouse, quick key or menu selection)
3. Set the pitch (by clicking the mouse on the pitch or using up/down arrow keys)
4. Press Enter

Step-by-Step: How to place an Accidental on an Exis ting Note
1. Select the note
2. Select the accidental (with the mouse, quick key or menu selection)

Crescendo and Diminuendo – Insert: Dynamic
From the Notes menu, using the quick keys < and >, or using the tool bar icons, you can apply these
graphical attributes to selected notes. They will take the staff position of the closest prior Dynamic or
Dynamic Variance.

For a graphical Crescendo or Diminuendo to alter playback, it must be used with Dynamics (Insert:
Dynamic…).
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In addition to the graphical Crescendo or Diminuendo, there is also the text option of cresc and decresc
under Insert: Dynamic Variance.

Step-by-step: How to increase/decrease volume durin g playback
Using Dynamics and Dynamic Variances together in NoteWorthy Composer will allow you
to increase or decrease volume over a section during play back. The Dynamic Variance
Crescendo (cresc) is an instruction to gradually increase volume, while Decrescendo
(decresc) instructs to gradually decrease volume. The Dynamics range from the very, very
soft Pianissimo (ppp), to the very, very loud Fortissimo (fff). As an example, follow the

instructions to create the staff below that will increase in volume from the p to the ff:

1. Enter the clef, time signature, notes and bar lines as above.

2. With the insertion point to the right of the first bar line, select Insert:  Dynamic or press the quick
key D.

3. On the Dynamic tab, select Style: Piano.

4. Check the box for Override Default Note Velocity and set the value for 127. Note velocity is how
hard a note is struck.

5. Check the box for Override Default MIDI Volume and set the value for 30. Here, you are setting
the volume (range of 1 to 127), instead of using the default.

6. Click OK  to exit the dialog box and you should see the p on the staff with the settings you selected-
p(127,30). The settings will not show in printed copies, only the p, as in the example staff.

7. With the insertion point to the right of the second bar line, select Insert:  Dynamic Variance or
press the quick key Y.

8. On the Dynamic Variance tab, select Style: Crescendo.

9. Click OK  to exit the dialog box and you should see cresc on the staff.

10. With the insertion point to the right of the third bar line, select Insert:  Dynamic or press the quick
key D.

11. On the Dynamic tab, select Style: Fortissimo.

12. Check Override Default Note Velocity and set the value for 127.

13. Check Override Default MIDI Volume and set the value for 127.

14. Click OK  to exit the dialog box and you should see the ff on the staff with the settings you
selected- ff(127,127). The settings will not show in printed copies, only the ff, as in the example
staff.

15. Click the Play Song  icon or press F5 to hear the result.

a j j LR[127,30]

j j j j
LV[127,127]

j j

a 44
 
j j

p
j j

cresc.
j j

ff
j j  
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Dotted, Slur, Tie and Accents

To assign a dot, double dot, staccato, staccatissimo, tenuto, accent or marcato to a note, follow the same
instructions as assigning an accidental as shown on page 44. If you do not have these icons showing and
want them, use View: Toolbars, Customize.

When entering a slur or tie, make sure you are using the correct symbol.

Slur:  Two or more notes of the same or differing pitch can be slurred. When notes are slurred
they will be played back in a smooth and connected manner. The command for the slur is
Notes: Slur and the quick key is the semicolon ( ; ).

Tie: Two notes of the same pitch can be tied. When notes are tied, the first note will be played
and held for the duration of both notes. The command for the tie is Notes: Tied and the quick
key is the slash ( / ).

Step-by-Step: How to Add a Slur to Notes
To add a slur to several notes, follow these steps.

1. Select all the notes, except the last note, that you want to be slurred.
2. Click the slur icon, use Notes: Slur or the quick key semicolon ( ; )

The selected notes and the next note to the right of the selected notes will be slurred.

Step-by-Step: How to Tie Notes
To tie two notes of the same pitch, you can assign the tie to the first note as you place the note. For

example,

1. Select the duration of the note and select the tie command (quick key /).
2. Press Enter to place the note and start of the note

The next note entered at the same pitch will be the recipient of the tie.

You can also select both notes that you want to be tied and select the Tie command with
Notes: Tie, click the Tie icon or use the quick key slash ( / ).

How do I change the direction of a slur or tie?
Select the notes that are tied or slurred and press Alt+Enter. Under the Notes tab, you will be able to select
the direction to be upward or downward.
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Step-by-Step: How to remove beams, slurs, dots, etc . from notes
Once you have issued a command to assign a beam, triplet, slur, tie, etc. to note(s), you can
remove the item later without deleting the notes and starting over. For example, to remove
the beam from some notes, select the beamed notes and press Ctrl+B or click the Beam icon.
To remove the staccato mark on a note, select the note and press the quick key, (comma) or
click the Staccato icon.

Step-by-Step: How to keep an icon active
If you will be entering more notes that are accented (Notes, Accent) than are not accented,
use Persistent Note Tools (Notes menu) to keep the Accent icon active (articulation). There
are several icon choices under this command – Accidental, Articulation, Augmentation Dot,
Color, Notehead, Slur, Tie, Stem Direction, Grace Note, Crescendo/Diminuendo.

Beam, Triplet, Grace Note, Stem Up, Stem Down

Beam Command
The Beam Command (found under the Edit menu, quick key Ctrl+B) can be used to beam selected flagged
notes. Flagged notes are eighth, sixteenth, thirty-second and sixty-fourth notes. The notes must be selected
(highlighted) before the Beam command will be available. (For more on selecting see page 10).

Triplet Command
The Triplet Command (found under the Edit menu, quick key Ctrl+T) can be used to create a triplet from
selected notes. The notes must be selected (highlighted) and be in a grouping that can form a triplet based
on the Time Signature before the Triplet command will be available. (For more on selecting see page 10).

Why are my Beam and Triplet commands not available?
You must select a proper sequence of notes for the commands to become active. For example to beam
notes, you must have at least two flagged (ex: eighth) notes selected (highlighted). Once selected, the beam
icon will become available as well as the ability to use the quick key Ctrl+B. Clicking the beam icon will
beam the selected notes.

Grace Note Command
The Grace Note Command (found under the Notes menu (Durations), quick key =) can be used to enter a
note as a Grace note.

Where do grace notes get their time?
When grace notes are used in a song, they do not take visual space for time, nor do they take time away
from the count for the measure. That is, the regular notes will line up in time and be counted for the beats in
the measure. However, in play back, grace notes steal time from the note following the grace note(s).

Stem Up and Stem Down
To set the stem direction for a note or rest, use the Notes: Stem Up (Shift+Up) and the Notes: Stem Down
(Shift+Down).
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Note Properties

Many properties for a note or rest can be accessed with Alt+Enter.

There is more that can be done to a note or group of notes than just assigning a duration, an accidental, a
slur or the like. When you select a note (or group of notes) and press Alt+Enter, a dialog box appears to
give you more control over the note (see below). If you are not familiar with how to select notes, see
Selecting on page 10. This Notation Properties dialog box allows you to change the spacing, mute the
note(s), turn off ledger lines, change tie and slur direction, change the color, mark it to never be printed and
more. For most any item entered (rests, bar lines, tempo variance, etc), you can select it and use Alt+Enter
to access the properties dialog box for that item to have more control.

Notes Tab

Extra Accidental
Spacing
To add more space
between a note and its
accidental, increase this
setting. This may be
useful when working
with Staff Layering
(page 50) if notes and
accidentals of other
staves are colliding. The
follow shows a note
with Extra Accidental
Note Spacing set to 0 for
the first note and set to 1
for the second note.

Extra Note Spacing
To add more space to the left of a note, increase this setting. If the note has an accidental, the space will be
added after the accidental and before the note. Again, one place this may be useful is with Staff Layering.

Override Stem Length
To change the length of a note stem or hide the note stem, use this setting. Set the stem length to 0 to hide
the stem for printing. One application for this is for Chant or spoken parts. The following shows 2 notes at
the default stem length, 2 notes at stem length set to 12 and 2 notes with the stem length set to 0.

Muted
Set a note of chord to be muted (not heard during play back).  Warning: If you mute the receiving note of a
tie, this will result in a stuck note for play back.

d k d k

k X k X k X
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No Leger Lines
Checking this option will turn off leger (ledger) lines for a note. In the example to
the right, the first note has leger lines turned on (not checked) and the second note
has checked “no leger lines.”

Use stem for articulations
In the example to the right, the first note has been entered with an Accent (Notes:
Accent). The second note was also entered with an accent, but the “Use stem for
articulations” was checked and the accent was moved to the stem end versus the note
head end.

If the selected note is part of a beam, you might also want to override the note's stem length in order to have
any articulations properly appear near the end of the note stem.

Slur Direction
If you would like to change the default direction of the slur, use this setting.
Selecting Downward will place the slur under the notes. Selecting Upward
will place the slur above the notes. In the example, the first 2 notes have the
slur in the Default or Downward position. The last 2 notes have the slur in
the Upward position. One application for changing the direction of the slur
may be when working with Staff Layering (page 50).

Tie Direction
If you would like to change the default direction of the tie, use this setting. Selecting Downward will place
the tie under the notes. Selecting Upward will place the tie above the notes. This is similar to the slur
direction example above.

Lyric Syllable
Any note, chord or rest can be used in the placement of lyrics. By default, all notes
except rests, grace notes, and notes that receive a tie or slur get attached to a lyric
syllable. This box can be used to override the default lyric attachment behavior.

The example to the right shows the second note of a slur receiving a lyric because the Lyric Syllable has
been set to Always.

You could also use this setting is you want to skip over a section of notes (at the beginning of a song or
otherwise) and not have lyrics assigned to those notes.

Notehead Color
Set the color of the notehead only – not the stem.  If you select (highlight) a note, and choose a color from
the toolbar, the entire note will be colored (same as setting Edit: Properties [Alt+Enter], Visibility tab,
Item Color). For more on color, see page 8.

Note: The properties above can be assigned to more than one note at a time. For example if you
wanted to set the slur and tie direction for an entire staff to upward, select the entire staff, press
Alt+Enter and under the Notes tab, set these items. Or, if the first 4 measures of your song do not
have lyrics, select those measures, press Alt+Enter and under the Notes tab, set the Lyric Syllable.
For more on selecting, see page 10.

k k

kA k
A

k k k k

La La

k k



Chapter 7 – Lyrics   50

Chords

Step-by-Step: How to enter chords
To enter chords (notes aligned vertically) in NoteWorthy Composer use Ctrl+Enter. For example:

1. Enter the first note of the chord
2. Place the insertion point to the right of that note and at the pitch for the second note.
3. Press Ctrl+Enter and the second note will be entered into a chord with the first note.
4. To enter more notes, repeat steps 2 &3.

You can read more about chords in the Help file by searching on Chord Member command.

NoteWorthy Composer only supports one voice per staff. The smallest duration in a chord is what is
counted for measures. You can force it to look like two voices in some cases by using the stem direction
control and changing longer duration notes into several smaller tied durations to get the chords right. You
can read all about the chord rules in the Help menu by searching on Chord Member Command.

To enter a rest in a chord, the rest must be entered first, it must be same or smaller duration than the note
and may need a stem direction assigned to it. You can mark the rest not to print by selecting the completed
chord, pressing Alt+Enter and under Rest Chord do not check - Show Rest.

For two voices on a staff, you will need to use Staff Layering . See the next section for details.

Staff layering (SATB - 2 Voices on a Staff)

Staff layering is the method used to place two voices on a staff. Staff layering will allow you to notate each
voice on a separate staff and then merge the staves for printing and viewing. The sample song file
layering.nwc demonstrates this feature.

1. Open layering.nwc. It is located in the Samples folder. Make sure you have the global setting at File:
Page Setup, Contents, Allow Layering turned on to be able to layer and unlayer.

2. Using View: Layering in Edit Mode – make sure this is not checked so the staves are not layered. Now
you can see how each voice is on a separate staff. Here you can edit each staff.

3. Click the top staff to make it active.

4. Press F2 (Staff Properties) and select the Visual tab. For the top staff, you will see that "Layering with
next staff" is checked. Press OK. Press Page Down to make the next staff active. Press F2. Here you
will see that it is not layered because the top staff will layer with it. Continue this process to see the
third staff is layered with next and the fourth staff is not layered. (The Layer with Next command is
also on the Staff menu).

5. With View: Layering in Edit Mode – check this to allow layering. Now the staves are layered again.
You can still use Page Up and Page Down to cycle through the staves and you can use Shift+F5 to play
only one voice.

If you want to create your own song with layering, you can use the satb template, which is the layering.nwc
file or start your own song.
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How to use the satb template to start a new song wi th layering

Go to File: New, General tab, click satb, Click OK, OK.

You will see that this template already has does not have the staves layered. However, the layered settings
are checked for the first and third staves. When you are ready to layer the staves again, go back to View:
Layering in Edit Mode and check it. (Make sure you have the global setting at File: Page Setup, Contents,
Allow Layering turned on to be able to layer and unlayer.)

You will also notice some lyrics have been entered with the Edit: Lyrics command as an example. When
you get ready to add your lyrics, go to Edit: Lyrics for the staff and under the Lyric 1 tab, delete the
example lyrics and enter your own. If you do not want lyrics, just delete the lyrics there and click OK.

How to start a blank new song with layering

If you want to start a new song with layering, the key is that for the staves you want to layer, you need to
set the same Clef. For the upper staff, you will need to go to Staff: Staff Properties, Visual tab, and check
Layer with Next Staff. This staff will then be layered with the staff below it when "Allow Layering" is
turned on.

Key Tips to Layering

• There are 3 commands associated with layering
-Staff: Staff Properties, Visual tab, Layer with next Staff
-View: Layering in Edit Mode
-The global setting at File: Page Setup, Contents, Allow Layering

• To move through layered staves, use Page Up and Page Down
Look for the active staff color to show what staff you are working with. Once you have

the staff active, you can edit the notes, use Tools: Staff Play (to just play that staff), etc. To set an
active staff color, go to Tools: Options, Color, Active Staff.

• Use Extra Note Spacing and Vertical Offset for Rests
To make space for notes that overlap more than you want, select the note, press Alt+Enter, under the
Notes tab, set Extra Note Spacing. The vertical position of a rest can be changed in the same way with
Vertical Offset.

• Change Direction of Tie or Slur
If you need to change the slur or tie direction of a note, select the notes, press ALt+Enter, under the
notes tab, change the direction.

Flow Direction – Repeats, Special Endings, Coda, etc.

There are several different ways to alter the direction of play. One way is to use repeats to play a section
again. If you have a few measures of a song you want repeated, use the Master Repeat Open and Master
Repeat Close under Insert:  Bar Line (Decorated). For example, if you enter the following piece in
NoteWorthy Composer and play it back you will hear and see the highlighted notes repeat between the
Master Repeat Open and Master Repeat Close. Never pair a Master Repeat with a Local Repeat.



Chapter 7 – Lyrics   52

� repeat section 

To repeat a section several times, use Local Repeat Open and Local Repeat Close under Bar Line
(Decorated). When you select Local Repeat Close, you will be prompted to enter the Repeat Count. An
example of a local repeat with a repeat count of three is below. The middle two measures will be played
back three times before continuing to the last measure. Never use a special ending with a local repeat. It
will not work.

�  repeat section 3 times 

Another way to use the repeat signs is with special endings. Special Endings are found in the
Insert menu. In the sample below, the third measure is the ending for the first pass (the 1st Special

Ending) and the Master Repeat Close directs play back to the start. On the second pass, the first special
ending is skipped and play goes to the 2nd Special Ending. The sample song jingle.nwc uses special
endings.

In addition to repeats and special endings, flow direction symbols also alter the direction of play and are
found in the Insert menu, under Flow Direction. To understand the different selections, it is important to
know two terms. First, Da Capo means from the beginning and is often abbreviated D.C. The second is Dal
Segno (D.S.) and means from the sign. In addition to the following example, the sample song file rose.nwc
also uses flow directions. It may be helpful to play the file and follow the play direction.

In the above example, the song will play through to the D.S. al Fine. After the D.S. al Fine instruction, the
song will go back and play from the sign to the Fine.

There are several song files in the Samples folder that demonstrate the use of flow direction signs and
repeats. The song files are named repeatx.nwc where x is a number. When you open the examples, go to the
File Info dialog box (Ctrl+I) for an explanation of what the file demonstrates.

An additional tip when working on the flow of a song is to break the song into blocks. These blocks are
individual sections that may or may not be played more than once, but they can be separated. Then give
each block a name, like A, B, C, etc. Then write out the flow of the song, using the block names. For
example, your song may flow ABACDAC. From that, figure out how to implement Repeats, Flow
Directions and Special Endings in your song. This will help you see at a higher level without all the
measures of notes clouding your view.

a 44
 
j j J j j j j J j j  

a 44
 
j j J j j j j (3)J j j  

a 44
 j j

x
j j j j j j  

Fine

a j j j j j j j j D.S.x al Fine

a 44 j j j j
 1.

j j J
 2.

j j
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Other Symbols from the Insert Menu

Bar Lines
A basic bar line can be entered on the staff with Insert: Bar Line or the quick keys: Tab key or * key.

For other bar lines, use Insert: Bar Line (Decorated). Here are the bar lines available:

The Local Repeat Close can be set from 2 to 250 repeats.

Under Style there is also Transparent. This holds spacing and properties for a bar line, but will not
display. This is different from placing a bar line and setting the visibility to never that does not hold the
spacing.

System Breaks
To break a system at printing, when inserting a bar line, check Force System Break. This needs to be done
in the top staff. If you do not set the break during bar line entry, you can after the fact, select the bar line,
press Alt+Enter and check the option.

Exclude From Bar Count
The bar line will not be included in the running count if this box is checked.

Marking Bar Lines Not to Print
Bar lines can be marked not to print or be set to a different color with the Visibility tab. If you do not set
these items during bar line entry, you can after the fact, select the bar line, press Alt+Enter and access the
Visibility tab.

Where do I set to end a staff with a Master Repeat Close?
Staff: Staff Properties, General tab, Ending Bar: Master Repeat Close. You can also choose from other
ending bars.

Where are the symbols for back to back repeats?
Go to Insert: Bar Line (Decorated) and enter the “close” for the bar line that you want. Then enter the
“open” for the bar line that you want the bar lines will then be combined to look like one symbol.

Clefs
Clefs can be entered on the staff with Insert: Clef or the quick key c. Some of the Clefs also have icons on
the toolbar. The clefs available from the Clef command are:

Treble

a
Bass

b
Alto

c
Tenor 

c
Percussion

]

Local Repeat: Open J Close  (2)J        Master Repeat: Open J CloseJ

Single Double Broken Single Broken Double Section Open Section Close
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How do I insert a clef that will play an octave up or down?
When you use Insert: Clef (quick key C), in the dialog box where Octave Shift is set for None, change the
setting to Octave Up or Octave Down.

Step-by-Step: How to change notes to a new clef
1. Select the clef and press Alt+Enter  to change the clef.

2. Select the notes to be changed and move them using Ctrl+Shift+ ↑↑↑↑↓↓↓↓.

3. Press F9 (View: Refresh Score) to update the key signature.

Step-by-Step: How to change the number of lines in a staff
When using the Percussion Clef, you may want to change the number of staff lines to be a
single line. When you add a new staff (Staff: New Staff), the default number of lines in the
staff is 5. To change that default:

1. For the active staff, go to Staff: Staff Properties (or press F2).

2. Under the Visual tab, in the Lines field, set the number for the staff.

Key Signatures
Key signatures can be entered on the staff with Insert: Key Signature, the quick key k or the icon
(shown to the left).  You can select a listed key signature or define one.

Is there an easy way to change the key of a song?
1. Use Tools: Force Accidentals to assign an accidental to each note.
2. Select the key signature, and change it using Alt+Enter. If no key exists, then use Insert: Key Signature

(or K) to enter a key signature at the beginning of the staff.
3. Select Tools: Audit Accidentals to update notes to the key.
4. If necessary to change the enharmonic spelling of notes, select Tools: Audit Enharmonic Spelling.

Time Signature
There are a few standard time signatures
represented by icons on the Insert menu.
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For more options, use the command Insert: Time Signature or the quick key g.

With Style set to standard you can select the Beats Per Measure from 1 to 99 and the Value of the Beat to 1,
2, 4, 8, 16, 32.

With Style set to Common time, the fields will both be set to 4 and the symbol will be entered on the staff.
With the Style set to Alla Breve, the fields will be set to 2 and the symbol will be entered on the staff (also
called cut time).

Can I put in the DDDD for a time signature of 4/4 or the EEEE for 2/2?

Yes. When you use Insert: Time Signature (quick key G), at the bottom of the dialog box where it lists
Standard Signature, select Common Time or Alla Breve. You can also click the icon on the Insert tool bar
for fast entry.

Performance Styles
With Insert: Performance Styles, there is a list of styles that you can insert from Ad Libitum to Volta
Subito. If you select Legato or Tenuto , notes will generally be played longer. If you select Staccato, notes
will generally be played shorter. Other selections will not alter the performance. If you would like to add a
style to the staff that is not on the list, you can always use Insert: Text.

Sustain Pedal
With Insert: Sustain Pedal, a down and released symbol can be entered.

Tempo and Tempo Variance
A tempo can be entered with Insert: Tempo, the quick key t or the icon. Using any of these methods
will bring up the Tempo Dialog Box.

The Base field sets the unit of the
tempo. The options are Eighth, Eighth
Dotted, Quarter, Quarter Dotted, Half,
Half Dotted. So, if you select quarter,
the tempo will be in units of quarter
notes per minute.

The Tempo field is base units per
minute.

The Optional Text Expression field
allows you to enter text related to the
tempo or you may leave it blank.

A tempo variance can be entered with Insert: Tempo Variance or the quick key e. Selecting either will
bring up the Tempo Variance Dialog Box.
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The options for Style include (icons available in View: Toolbars, Customize):

Breath Mark : The breath mark is represented graphically in the score and indicates that the performer
should take a breath at this position. You can optionally specify a Delay (in 16th notes) which will
influence the play back of the staff. The delay should only be specified for one instance of the mark

at any given vertical position in the song. The breath mark can also be entered with the icon.

Fermata: The fermata is similar to the breath mark in that it is represented symbolically in the score and
has a corresponding delay - Delay (in 16th notes). The delay should only be specified for one
instance of the mark at any given vertical position in the song. The fermata can also be entered with

the icon.

Caesura Mark: The caesura mark is represented graphically in the score and indicates that the performer
should take a brief, silent pause. You can optionally specify a Delay (in 16th notes) which will
influence the play back of the staff. The delay should only be specified for one instance of the

mark at any given vertical position in the song.

Accelerando, Allargando, Rallentando, Ritardando, Ritenuto, Rubato, Stringendo:  These marks do
not use a predefined delay. They scan on both sides of the variance event to find the presence of tempo
marks. If they are found, then the change from one tempo to the next is introduced gradually at a rate
determined by the distance up to the next tempo mark. If a tempo mark is not found either before or after
the variance mark, then no change in the tempo is introduced into the play back of the staff.

In this example, Allargando has been selected under Style. Since there is a tempo entry on each side of the
tempo variance the tempo will be slowed from 220 to 120 from the allarg. to the 120 tempo entry.

Note: It is up to you to make sure that the tempo variance that is actually implemented reflects the
change indicated in the text. For example, it is technically possible to create a section which slows
down in tempo and yet is labeled as Accelerando .

Step-by-Step: How to enter a Fermata
The fermata symbol over a note indicates to hold the note longer than its written duration. The fastest way
to enter a fermata is to click on the icon on the Insert tool bar. The following steps illustrate how to place a
fermata over a note with the Insert menu.

1. Place the insertion point to the left of the note that you want to fermata.

2. Select Insert:  Tempo Variance or press E.

3. On the Tempo Variance tab, select Fermata for style

4. If you do not like the position of the fermata, select (highlight) the diamond beside
the fermata and press Alt+Enter  to edit the staff position under the Placement tab.

a 44 k k k
y
k

 

LG =220k k k k k k Lallarg.k k k k
LG =120

k k
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a 44 LVol = 127

k k k k
LVol Fades Over 2 Measures

{mpc}k k k k k k k k

Fade volume with the Multi-Point Controller
The Multi-Point Controller  (Insert menu) allows sophisticated control over the play of a song. For
example, it can be used to fade the volume, speed up a section or implement a pitch bend.

The following example demonstrates how it can be used to fade out the volume. In NoteWorthy Composer,
create a staff with notes like the one below.

Place the insertion point after the first bar line and select Insert: Multi-Point Controller . Use the same
settings as in the dialog box below.

Controller - Volume:  indicates this controller will affect volume

Style - Linear Sweep: the change will be gradual; not all at once

Time Offset Multiplier - Quarter:  Multiply by Time Offset for duration

Linear Sweep Contour - 1: the size steps the sweep will take during the control

The remaining settings indicate the first note will be at a volume of 127 and over a time period of 8
Quarter  notes (Time Offset x Multiplier), the volume will decrease to 29. Click OK .

Play the staff and you will hear the volume fade.

How does the Linear Sweep Contour in the MPC work?
The Linear Sweep Contour defines how large a change to the controller value will be considered
significant. In the case of pitch bend, where the value can be swept over thousands of values, each and
every change of only 3 or 4 is not very important. In this case, you might use a value of 100, or even more,
depending on how smooth you wish the pitch bend to be. This allows NWC to lean out the number of
control changes sent to the MIDI device, which can significantly improve performance.

Think of it like this. If you started at 0 and wanted to count out loud to 10000 in 2 minutes, then:

• Using a contour setting of 1, you would count like this: "1, 2, 3, 4, 5, 6, 7, 8, 9..." all the way to 10000,
and you would have to speak very fast to finish in 2 minutes.



Chapter 7 – Lyrics   58

• Using a contour setting of 100, you would count: "100, 200, 300, 400, 500..." all the way to 10000, and
you would probably have no trouble finishing in 2 minutes.

The same is true in an MPC. A higher contour value makes it easier for NWC to change the value from the
value of 1 up to the value of 10000.

Enter music symbols not listed
NoteWorthy Composer allows for the use of different fonts with File: Page Setup, Fonts. The command
Insert: Text  allows for the placement of items on or around the staff. Using these tools, you can insert
items such as bow markings, rehearsal marks and the like.

The notation items from the NoteWorthy Composer font can be selected with Insert: Text. These will not
affect playback. You can also use music fonts that you have purchased or that you have created. In
addition, you will find several music symbol fonts created by fellow NWC users in the online community.

Common Questions Related to Inserting Items

Is there a way to quickly edit symbols?
There is an easy way to edit symbols like the clef, key signature, tempo and text. First, select (highlight) the
item, then press Alt+Enter. The dialog box for that item will appear for quick editing.

When I Insert Expressions, I only get 1 tab and my friends get 3 tabs. Why?
The difference is the setting for Tools: Options, Editor, Smart Properties Insert.

When enabled, the Visibility properties for new items are automatically configured with default settings.
The Placement properties are set by finding a similar item elsewhere in the staff, and then using it as a basis
for positioning the new item. If a similar item is not found, the program decides on the placement
properties based on reasonable defaults.

When disabled, all available properties for new items must be set manually. The properties are initially set
to whatever was used the last time this type item was added. Here you would get the 3 tabs so you can
access all the settings.

How do I delete Text, etc without deleting notes underneath?
If you have not Preserved Width for an inserted item (Text, Tempo, Dynamic, etc), this item does not have
a width on the staff. This allows notes to be placed directly under the item. Since the item has no width for
you to select, a small gray diamond is placed to the left of the item. The diamond gives you something to
select for editing or deleting (the diamond may be changed to an anchor with Tools: Options, Editor, Small
Expression Anchor).

When you want to delete, copy or edit the items without width, the focus will be the diamond - not the
item.

To delete the item, place the insertion point to the left of the diamond and press delete. Or, place the
insertion point to the right of the diamond and press back space. Or, select the diamond and press delete.

To copy the item, select the diamond and press Ctrl+C.

To edit the item, select the diamond and press Alt+Enter.
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What does Preserve Width mean?
You will see the option to Preserve Width in dialog boxes under Placement. One example is Insert: Text. If
you select Preserve Width, the text will take up its own width on the staff and notes will start after the text.
If you do not select Preserve Width, the text will not take any width on the staff. In this case, text placed at
the top of the staff will allow notes to be entered under the text. If you do not Preserve Width, the symbol
or text you are entering will appear with a diamond beside it. Since the item has no width of its own, the
diamond gives you something to select for editing or deleting. The diamond will not appear in your prints
(the diamond may be changed to an anchor with Tools: Options, Editor, Small Expression Anchor).

Text entered with Insert: Text can be deleted, copied and pasted and edited. Depending on whether you
Preserved Width or not, the focus of the commands will be different. If you Preserved Width, the focus will
be on the text. If you did not Preserve Width, the focus will be the diamond.

To delete the text, place the insertion point to the left of the focus and press delete. Or, place the insertion
point to the right of the focus and press back space. Or, select the focus and press delete. To copy the text,
select the focus and press Ctrl+C. To edit the text, select the focus and press Alt+Enter.

Is there a find feature for notes and symbols?
Go to Edit: Find (quick key Ctrl+F) to set what you would like to find on a staff. In the dialog box, you are
able to search on an Expression or a Category of entries such as Dynamics, Flow Direction, etc. Once you
have found the first item, you can continue through the staff finding more of those items by pressing F3
(Edit: Find Next).

When you search by Expression, not only can you enter text that you want to find in a staff, you can also
search for notes of a certain duration, notes with an accent, grace notes, etc by entering that item's text
representation. You will find some examples of this in the NoteWorthy Composer Help file under Help:
Search for Help on, Find Command.

Placement and Visibility Tabs
When using the Insert menu, you will see the Placement tab and the Visibility tab (if you have the Tools:
Options, Editor, Smart Properties Insert option disabled). If you select an item, such as tempo or text and
press Alt+Enter to edit it, you will see these tabs. They are described in detail below.

Placement Tab

This tab deals with how the item will be placed on the staff.

Staff Position
This sets the vertical position of the item on the staff. A staff position of 0 is on the center staff line. +5
would be just above the staff and –5 would be just below the staff.



Chapter 7 – Lyrics   60

Preserve Width
To understand this setting, take the example of Insert: Text. If you select Preserve Width, the text will take
up its own width on the staff and notes will start after the text. If you do not select Preserve Width, the text
will not take any width on the staff. In this case, text placed at the top of the staff will allow notes to be
entered under the text. If you do not Preserve Width, the symbol or text you are entering will appear with a
diamond (or anchor) beside it. Since the item has no width of its own, the diamond (or anchor) gives you
something to select for editing or deleting. The diamond (or anchor) will not appear in your prints.

Text entered with Insert: Text can be deleted, copied and pasted and edited. Depending on whether you
Preserved Width or not, the focus of the commands will be different. If you Preserved Width, the focus will
be on the text. If you did not Preserve Width, the focus will be the diamond (or anchor).

To delete the text, place the insertion point to the left of the focus and press delete. Or, place the insertion
point to the right of the focus and press back space. Or, select the focus and press delete. To copy the text,
select the focus and press Ctrl+C. To edit the text, select the focus and press Alt+Enter.

If you would like a larger symbol to work with instead of the diamond, go to Tools: Options, and un-check
Small Expression Anchor. This will display an anchor instead of a diamond.

Justification
This field is used to control how the item is justified within its space on the staff – to the left, center or right
of the space. This can be especially useful when the item does not preserve its width. It might also be useful
when the item uses best fit placement and is allocated additional space on the staff during note alignment.

Alignment/Placement
This field controls how the text or symbol expression will be inserted and aligned in a multi-staff system.
The options are:

Best Fit: The item will be placed in the system in the most efficient way possible. It will tend to stay near
the note, bar, or signature that precedes it, unless obstructed by a prior item.

Best Fit Forward: The item will be placed in the system in the most efficient way possible. It will tend to
stay near the next note, bar, or signature that appears after it in the staff.

As Staff Signature: The item will be treated as a staff signature. It will be aligned in the system with any
other signature item appearing in other staves at the same horizontal position.

At Next Note/Bar: The item will be shifted forward such that it appears at the start of the next note or bar
line. In the editor, a dashed line to the anchor position will be shown.
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Visibility Tab
This tab deals with how the item will be displayed on the printed
page.

Show on printed page
This field allows you to set if you want the note, rest or symbol
to be shown on the printed page. The options are:

Default: The item will not appear in the final printout if it is
generally not appropriate to do so.

Always: The item will always appear in the final printout.

Top Staff Only: The item will appear in print only if it is contained in the top staff of the system.

Single Staff Prints: The item will appear in print only when a single staff is included in the system.

Multi Staff Prints:  The item will appear in print only when multiple staves are included in the system.

Never: The item will never appear in print.

This option could be used to hide bar lines if you do not want them in your printed song. With
staff layering, you could hide the rests place holders on one staff so they are not shown during
layering. You could also print blank staff paper by hiding items on the staff.

Item Color
This field controls the color of the item. The options are default and Highlight 1-7. The colors for the
default and highlights are set in Tools: Options, Color tab.

Multi-measure Rest

Using the Insert menu, you can place a multi-measure rest.

When you only have one staff (visible in the editor and for printing ),
the multi-measure rest symbol with the total number bars of rest will be
shown.

When you have more than one staff, in the editor, the rest will stretch as long as the other measures

a 44
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For printing (with more than one staff), you have options….

Bars of Rest
This field allows you to set the number of bars of rest.

When Visible on Printed Page
Show Only Once - You can use this option to force the
multi-measure rest to display the total number of bars of
rest in a multiple staff printout, even if it did not fit
entirely within the first system. When this is set, the MMR
itself will not appear in later systems, but whole bar rests
or empty bars might appear in its place, depending on the
other options.

Show Only Once – checked; Visibility – Always Show Only Once – not checked, Vis - Always

a 44
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When Hidden
Print Bar Lines  - When the MMR is hidden, this option will cause bar line boundaries to be displayed on
the printed page for each empty measure of rest.

Print Whole Rests - When the MMR is hidden, this option will cause a whole rest to be displayed on the
printed page for each measure of rest.

Print Bar Lines & Whole Rests–checked, Vis -Default Print Bar Lines&Rests–not checked, Vis-Default

How do I keep the multi-measure rest sections from printing in a multi-staff print?

After you have used the command Insert: Multi-measure Rest, at the start of that rest, go to Insert: Boundary Change
and check – Start a collapsible section. Start Collapsible Section - check this for a staff that has a multi-measure rest
when you do not want it to be printed. Rests will be printed to keep a system complete.

a 44 l l l
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Chapter 7
Lyrics
This section covers lyrics in NoteWorthy Composer, as well as importing/exporting to MIDI and Karaoke
files.

Working with Lyrics in NoteWorthy Composer

Lyrics, the words for a song, are entered with the command Edit: Lyrics . The command can be accessed in
any of the following manners:

• Select the Edit command menu and then select Lyrics...
• The quick key Ctrl+L
• The Lyric icon, which is the blue capital L

To set lyrics for a staff, click the staff to make it active and access the lyrics command (Ctrl+L). Once you
have the Staff Lyrics dialog box open, on the Configuration  tab, set how many lyric lines your song will
have with Line Count. Select the number of lines with the drop down box. This can be changed at anytime.
So, if you are not sure how many lines you will have, start with "1 Lyric Line" as shown below. You cannot
add lyrics until you have set the Line Count.

Setting Line Count to "1 Lyric Line" will make the Lyric 1 tab available. Click on the Lyric 1  tab. Click in
the white box. You will enter your lyrics in this box, as shown below. Then click OK. If you already have
notes placed on the staff, the lyrics will appear with the notes. If you do not have notes on the staff yet, the
lyrics will show once notes are added. When you need to change or add to the lyrics, go back to Edit:
Lyrics.

For more specifics and examples, see...

• The Lyrics Command section of the online help file.
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• Sample song files, such as jingle.nwc and savequen.nwc - go to Edit: Lyrics to see how lyrics were
entered.

Setting Notes to Not Have Lyrics
Lyrics will start at the first note of the song. If you have notes at the beginning, or anywhere in the song,
that that you do not want lyrics assigned to, there are 2 methods to skip the notes.
Method 1
Set the property of the notes to never have lyrics. To do this, select/highlight the notes that you do not want
to have lyrics, press Alt+Enter to access the note properties dialog box, and under the Notes tab, set Lyric
Syllable to Never. See the diagram below.

Method 2
Use an _ (underscore) in the Lyric Editor (Ctrl+L) for each note you want to skip. If you have several lines
of lyrics and you want lyrics both assigned and not assinged to the same notes based on the verse, you will
need to use the underscores. For example, entering _ _ _ _ in a Lyrics tab will skip 4 notes. These notes will
not have lyrics and the underscore will not show in the editor or print. See the diagram below for an
example.

Assigning Lyrics to Tied or Slurred Notes
By default, lyrics are not assigned to notes that are the beneficiary of a tie or slur. If you would like to
assign lyrics to these notes, select the notes, press Alt+Enter, under the Notes tab, set Lyric Syllable to
Always.

Changing the Font Size and Style
In some cases you may want to keep the staff size the same, but increase the size of the lyrics. You may
also want to use a font other than the default Times New Roman. To change the lyric size and font for an
open file:

1. Select File: Page Setup.
2. Click the Fonts tab.
3. In the scroll box, click Staff Lyric and click Modify.
4. In the Font dialog box, change the Font, Font style and Size as you like.
5. Click OK.
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Remember: If you use fonts that others do not have, your song will not display correctly on their machine.

Assigning Lyrics Both Above and Below a Staff
To assign lyrics above the staff and below the staff, you will need to use staff layering. See page 50 for
details on staff layering.

With staff layering, you will create one staff with the lyrics on top of the staff and create another staff with
the lyrics under the staff. Then you will layer the 2 staves to be one staff with lyrics on top and bottom.

For the staff that you want to assign lyrics above, click the staff to make it active, use Ctrl+L (Edit: Lyrics)
to open the lyric editor and on the Configuration tab, for Staff Placement - Assignment, set Top. For the
staff you want to assign lyrics below the staff, set this to Bottom.

Cutting and Pasting Lyrics
When working with lyrics you may want to copy, cut and paste lyrics within the Staff Lyrics dialog box or
between NoteWorthy Composer and another application. You can copy, cut and paste lyrics by using the
Windows clipboard manipulation keys.

1. While in the lyric editor (Ctrl+L), select (highlight) the section of lyrics you want to work with by
holding down the left mouse button and dragging it across the lyrics or by using
Ctrl+Shift+Left/Right Arrow Key.

2. Press Ctrl+C to copy the lyrics or press Ctrl+X to cut the lyrics.
3. Place your insertion point where you want to insert the copied or cut lyrics.
4. Paste the lyrics by pressing Ctrl+V.

Assigning Several Words to One Note
The underscore ( _ ) can be used to connect several lyric words to one note. For example, "Word1_Word2"
entered in the Staff Lyrics Editor (Edit: Lyrics) would assign "Word1 Word2" to a single note. To use this,
make sure you have “Underscore shown as space” on the Lyrics Configuration tab checked.

Alignment of Lyrics
There are a few more options for lyrics on the Configuration tab that were not covered in the above
sections.

Assign Syllable Using:  This field controls how the lyric text will be aligned and justified
underneath its corresponding note(s). Lyric alignment can be forced to use:

Start of Accidental/Note: This aligns the lyric syllables on the far left side of each
corresponding note, starting at the same location as any accidentals that would appear on the
note.

Standard Rules: This aligns the lyric using standard conventions for lyrics in notation.
Normally, the lyric will be centered under the notes. If a multi-note phrase encompasses the
syllable, then the lyric will be left aligned with the start of the notehead.

Offset:  This field is used to add space near the staff boundary. The lyric lines will be placed above or
below this space, thus making room for things like special endings at the top of a staff.

Lyric

n k
Lyric

n k
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Staff Properties Vertical Size:  These settings for Upper and Lower are also found under Staff:
Staff Properties, Visual tab. However, as you add lyrics lines to a staff, these numbers are increased as
needed to make room for the lyrics above or below the staff (depending on the Alignment of lyrics –
Bottom or Top).

Lyrics in MIDI and Karaoke Files

For the latest information and links to other products that may assist, check the online faq and user
community on this subject.

To add lyrics to a *.mid file
You can save your song file as a MIDI File using the File: Save As command. If lyrics are present in any
non-muted staff, they will be exported along with the performance data. When saving to a Type 0 MIDI
file, only one lyric is exported since all data is saved into a single performance track.

The actual lyrics are exported exactly like they play back in NoteWorthy Composer. The lyric syllables are
included in the MIDI data just like they are highlighted when playing in NoteWorthy Composer.

What is imported when a MIDI file has lyrics?
MIDI files can be imported into NoteWorthy Composer song files using the File: Import command.
However, MIDI files are not notation based files. They generally contain raw performance data that
represents exactly how a song should be played, but not really how it should be notated.

MIDI files can optionally include text events, including text identified as Lyric Text. Text that is included
in a MIDI file is not associated with any particular note pitch or duration, and can appear anywhere in the
file, even if no instrument/note performance data is present. Lyric text in a MIDI file simply identifies a
chronological sequence of syllables that should be sung with the song, and the time at which each syllable
should start to be sung. The actual length of time that each syllable is sung is not specified in the MIDI file
(although it obviously does not extend beyond the start time of the next syllable). These syllables might
correspond to note events that are also included in the MIDI file, but there is no rule that it must be this
way.

So, what does this all have to do with NoteWorthy Composer? Well, since lyric text is not bounded/framed
by any other MIDI performance data, NoteWorthy Composer imports each lyric track into a separate lyric-
only staff when importing MIDI data into NWC format. Each lyric-only staff imported into NoteWorthy
Composer has the following properties:

• Each lyric syllable is attached to a fake, muted note that is added to the staff solely for the purpose
of attaching lyric text (it does not sound during play back)

• The staff itself is given only a single staff line, to make it clear that it is a vocal only track
• Each lyric staff will be marked in a Lyrics group from File|Page Setup|Contents and Staff|Staff

Properties|General, to make them easier to find and manipulate
• All notation on the staff is set to Never show on the printed page, so only the lyric text will appear

when printed
• All fake notes entered on the staff will appear in hidden treble clef, although technically the notes

themselves have no significance, except as a medium for attaching the lyric syllables found in the
file (you can change the hidden clef without having any effect on the lyric staff)
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In addition, NoteWorthy Composer will try to layer an imported lyric staff with the corresponding note data
that matches the lyric. This does not always work very well, due to the inherent limitations described earlier
in this article. NoteWorthy Composer uses the following scheme when layering a lyric staff with a notation
staff during import:

• first, the track where the MIDI lyric events are found is checked for MIDI note data
• if MIDI note data is present, the list of NoteWorthy Composer import instructions are checked to

see if any note data is being imported from this track
• if multiple NoteWorthy Composer import instructions are found for this track, the first one is

considered the source for a matching a notation staff for the MIDI lyrics found in the file
• the notation staff generated from the import instruction is then layered with the lyric staff

generated from the MIDI lyrics
• if no matching import instruction is found, or no note events are in the track that contains MIDI

lyrics, then the lyric staff will not be layered within NoteWorthy Composer; it will appear at the
bottom of the score, after the notation staves

After an import is completed, you can try several things to improve the results of the lyric import:

If the lyric staff is layered with the wrong notation staff, you can layer it with a different notation staff:

1. turn off the layering option on the notation staff (press F2 while the notation staff above the lyric
is active, then click the Visual tab, turn off option Layer with next staff)

2. now, make the lyric staff active (which can now be easily done by clicking on it)
3. now move the lyric staff around using Ctrl+Shift+Page Down/Up until it is under the notation staff

that appears as though it represents the vocals
4. lastly, you can optionally enable layering on the notation staff directly above the lyric staff so that

the lyrics will appear to belong to this staff when printing or displaying in NoteWorthy Composer
Viewer

If you are feeling confident, you can also move the lyric text from the lyric staff over to the actual notation
staff that you think corresponds to the lyric text:

1. use Page Up/Down until the imported lyric staff is active
2. open the lyric editor using Edit|Lyrics or Ctrl+L
3. press Ctrl+Shift+End to highlight the entire lyric
4. press Ctrl+C to copy all of the selected lyric text
5. press Cancel to close this lyric editor
6. activate the notation staff to which you want to add these lyrics (again, using Page Up/Down is an

easy way to do this)
7. open up the lyric editor for this notation staff
8. on the Configuration tab, assign the Line Count field to 1 Lyric Line
9. click on the Lyric 1 tab
10. in the lyric text box, press Ctrl+V to paste the lyrics
11. press OK to complete the job

You now have these lyrics attached to the notation staff. You will probably find that some tweaking of the
lyrics and note properties will be required in order to match the lyric syllables with the correct notes on the
staff. In some cases, this effort might be enough to convince you to use the layered lyric staff instead. If
you decide not to keep the original lyric staff, you can remove it by making it active, then pressing Ctrl+D.

Does NWC support karaoke (*.kar) files?
Karaoke files conform to the Official MIDI Specification, but include custom text formats for the inclusion
of lyrics and other text. Karaoke files do not utilize the standard Lyric Meta Event for inclusion of song
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lyrics. Karaoke files use the general purpose Text Meta Event for inclusion of lyrics. NoteWorthy
Composer will import lyric text events from a karaoke file as long as the file name has the correct *.kar file
extension. The import uses the same procedure as described above, except the lyric text is derived from the
Text Meta Event, rather than the official Lyric Meta Event.

On export to a MIDI file, NoteWorthy Composer uses the standard Lyric Meta Event for saving lyrics into a
standard MIDI file. NoteWorthy Composer does not save files using the custom Karaoke File (*.kar) format
extensions. It uses the standard defined by the Official MIDI Specification.
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Chapter 8
MIDI Recording
To get NoteWorthy Composer to accept input from a MIDI keyboard, you need:

• A MIDI keyboard (needs to be MIDI compatible, not just an electric keyboard)
• A sound card that has a MIDI port or a MIDI interface card
• MIDI cable
• NoteWorthy Composer

It does not matter to NoteWorthy Composer how the MIDI keyboard is connected to the computer (USB,
Serial, PCMIA, your sound card MIDI/joystick port,etc) as long as the MIDI hardware is there and the
drivers are installed. For example, you can connect your MIDI keyboard to a USB port with the proper
interfaces/drivers and NoteWorthy Composer will accept the input. If you have a USB port and want to
connect a MIDI keyboard at that port, you will need to purchase a MIDI interface that includes the MIDI
drivers.

If you are connecting the MIDI keyboard to your computer via the sound card joystick/MIDI port, the
MIDI cable needed to connect to your computer will have 2 5-Pin DIN connectors on one end (for
connecting to the MIDI keyboard) and a DB15 Male and Female connector on the other end (to connect to
your joystick/MIDI port and have access available to game port).

There are 2 ways to input notes with a MIDI keyboard. Live play will record what you are playing with
duration. Step play will enter note pitches as you press keys without duration.

Step Recording

Step play will enter note pitches as you press keys without duration. This means you can enter the note
pitch from the MIDI keyboard. The duration is not recorded, just the pitch. Since this is not a live
recording, notes and chords can be entered at your own pace. To enter notes in step time:

1. Go to Tools: Options and click the Record tab.

2. If not already set up, on the Record tab, select the Input Device for you system. This will not need
to be set every time unless you change devices often.

3. On the Midi  tab, set MIDI port usage to While Active or Always. This will not need to be set
every time.

4. Select Tools: MIDI Input Active  or click the MIDI Input Active  icon.

Now when you press a key (or keys for a chord) the note(s) will be entered in the score on the active staff.
Durations for the notes can be selected using the computer keyboard quick keys, the mouse to click the note
duration icons or possibly from controllers on your MIDI keyboard. Search the Help file for “MIDI Input
Active” for more information on MIDI keyboard controllers that can be used to set note duration.

Live Recording

Live play will record what you are playing with duration.
1. Go to Tools: Options and click the Record tab.
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2. If not already set up, under the Record tab, select the Input Device for your system. This will not
need to be set every time.

3. Still under the Record tab, under Import Options , select the placement of the notated recording
when completed. The choices: New Window, Record Group (of score playing while recording) or
Buffer Only.

4. Click OK .

5. Press Ctrl+N, Rhythm tab and select a score that you will use for background play as you record.
A score must be open and playing to record. NoteWorthy Composer provides several Rhythm
templates that are helpful in recording or you can use your own song file.

6. Click the Record        icon or press F4.

7. Play your MIDI keyboard (or MIDI other device) along with the rhythm or song.

8. Press F6 to stop recording or recording will automatically stop at the end of the background song.

Recording will appear where you set it in Import Options. Under Import Options, if you selected:
New Window - The recording will appear in a new window.

Record Group - The recording will show in the background song’s window. The recording will be in
its own group entitled Record.

Buffer Only  - Access the notated recording with Staff: Import Recording .

How can I get left hand and right hand staves to show on recording?

When recording, here are some settings to get the 2 staves from right hand and left hand:

Tools: Options, Import, Maximum Single track chord size - Decrease this number, 12 may be a good
starting point. Record, see how the new number works, change number and try again, until you get better
results

- and/or -

Staff: Import Recording; Once you record a song, you can import with this command as many times as you
want. You can import the first time and set the note range to be for the right hand. This will set a staff for
the right hand. Import a second time and set the note range to be for the left hand part. This will set the staff
for the left hand under the first staff.
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Chapter 9

Printing

File: Page Setup
Here you can set things like what staves are printed, if staff labels should be printed, margins, fonts, etc.

Contents
Use this tab to check the staves that you want to show in the display and thus will be printed.

Groups
Use this list box to select the parts that you want to appear in the editor. You can select or deselect entire
staff groups using the group list on the left side of the staff list.

Visible Parts
Use this list box to select the parts that you want to appear in the editor. You can select or deselect entire
staff groups using the group list on the left side of the staff list.

Fonts
Use this tab to set the size of the printed staff and fonts used.

The Staff Metrics box lists
the point size used for the
printed staff and the
typeface used. Select the
Change command to edit
this information.

Staff Size: This is the size
of the printed staff in
points. This setting will not
change the size of the staff
in the editor. That is
controlled with View:
Zoom.

When you change this
setting, you have the option
to check Proportionately
Scale Other Staff Font
Sizes. If you have this
checked, items like Text
Expressions and Lyrics will
be changed at the same

proportion as the change in staff size. If not checked, those items will remain the same.

Notation Typeface: The typeface is what will be used for most of the standard notation on the staff,
including noteheads, clefs, accidentals, dynamics, and note stem flags. Any NWC2 symbol fonts currently
installed on the system are included in the drop down list.
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The list below staff metrics is the list of font types that are used by the program. You can customize the
typeface and styles for each font type, and the information will be saved inside each song file. The font
types are used in the following manner:

Staff Italic:  Used in the staff for dynamics, text expressions, and other italic text

Staff Bold: Used for bold text that appears in a staff, such as tempo numbers, special ending numbers, and
text expressions

Staff Lyric:  Used for lyric text in a staff

Page Title Text: Used for the title page when printing a score

Page Text: Used for the author text when printing a score

Page Small Text: Used for copyright and page number text in a printout

User '#': Available for use in the Text Expression item

To change the size, typeface and style of an item, click the item and click Modify… or double click the
item. The fonts available are based on those fonts installed on your system.

Options
Set print details of your song with this tab.

Title Page Info
If you want the title, author, lyricist,
and copyright notice printed, check
this box. If you do not check it, all
pages will have the same format –
with no title info. The title page info
is taken from what is entered in File:
Info.

Extend last system
If you want each staff to be extended
out to the right margin in the final
system, then check this box. If this is
not checked, your last system may
not be right aligned with the other
systems in a printout.

Justify printed systems vertically
As the title indicts, checking this field will spread systems vertically on the page. The systems would look
like they are centered vertically verses starting at top.

Increase spacing for longer notes
For notes to take up space based on their duration, check this options (image on left). For a more compact
staff where notes will all take up the same space, do not check this option (image on right).
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Print multi-staff system separator marks
This option enables a system separator mark to be printed between adjacent systems. The separator mark
will only be placed on a system that contains multiple parts or displays a connecting orchestral brace.

Page Numbering
Page numbers are shown in the Upper Right Corner of the printed page. If you want page numbers to show,
check this box.

From
If you select page numbers to be printed, you can indicate what number you want the count to start at,
starting at 1.

Staff Labels
The options of printing staff labels are set here. The staff labels used are what has been entered in Staff:
Staff Properties, General tab, Staff Label. The options are:

• None: The Staff Labels will not appear in the printout.

• First System: The Staff Label will appear only once, on the top of the first page.

• Top Systems: The Staff Label will appear on the top system of the first page in the printout and the
Abbreviated name will be used for the top systems after that.

• All Systems: The Staff Label will appear for the staves in the first system and the Abbreviated
name will be used for all systems after that.

Measure Numbers
Set measures numbers to be None, Plain, Boxed or Circled. If you select an option other than none, in the
editor, measure numbers will appear on top of nearly every bar line (except local repeat close items). When
printing, the measure number appears at the front of each system in the printout.

Measure Start
If measure numbers will be displayed, set the starting number of the first bar.

Margins
With this tab, Margins for the Top, Inside Edge, Outside Edge and Bottom can be set. The Measure Units
can be Inches or Centimeters.  In addition, Mirror Margins  can be set for a double sided print. That is, the
inside edge and outside edge are reversed from page to page. On odd numbered pages, the inside edge is on
the left. On even numbered pages, the inside edge is on the right.

Preview
Preview your song before printing. This command can also be accessed from File: Print Preview. See more
details below.

File: Printer Setup
The settings available here will vary with your printer. But in general, this will be where you set your
Printer, Paper Size, Paper Orientation.

File: Print Preview
With this command, you can Preview the song before printing. Once you Preview mode, the options are:
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Back, Next, Start: These selections move you though the scores. Back will move back a page for each
access, while Next will move forward a page for each access. Start will return the view to the first page of
the score.

Copy: This command allows for the page to be copied to the clipboard or a *.emf file. See the section
Move your song file to another application on page 21 for more details.

Done: This will close the Print Preview and return the focus to the staff if you accessed Print: Preview and
to the File: Page Setup, Preview tab if you accessed Print Preview from there.

Zoom In and Out: Use the left and right mouse buttons to zoom in and out of the previewed page.

File: Print
Once you like what you see in Print Preview and you are ready to print , do one of the following:

� Select the File menu option and Print .

� Click the Print  icon.

� Press Ctrl+P .

This will access the Print dialog box. The options here will vary with your printer. In general, this is where
you will set the number of copies and start the print.

Advanced: If you will use the same print settings for most of your songs, you may want to create a Print
template. You can also edit the existing templates with your print margins and other settings. For more
information on Templates, see page 20.

How can items be hidden (not printed)?
Most symbols, notes, bar lines, etc. can be hidden for printing. To hide an item:

1. Select the item.

2. Press Alt+Enter  to open the Properties Dialog Box.

3. Click the Visibility  tab.

4. Set “Show on printed page” to Never.

Once you know how to hide items, you can do print things like: blank sheet music, music that does not
have bar lines, a blank staff line below a staff of music, lyrics that do not look like they are assigned to
notes.

How can notes be printed with a different color?
Select notes and press Alt+Enter, on the Visibility tab, select one of the Highlight colors. If you want the
entire staff printed a different color, click the staff, click the Visual tab, and under color, select one of the
highlight colors. If you want to change the color selection, go to Tools: Options, Color.

How can I get more (or less) on a printed page?
If you do not like the format you see in Print Preview or Print, some of the items you can change to try and
get the look you want include:

• File: Page Setup, Margins

• File: Page Setup, Fonts, Staff Metrics – Change, Staff Size

• File: Page Setup, Options, Increase note spacing for larger....
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• File: Page Setup, Fonts

• Staff: Staff Properties, Visual, Upper Boundary

• Insert: Bar Lines (Decorated), Force System Break

How can I move the song or a staff to another application to work with and print from there?
See the section Move your song file to another application on page 21.

How do I  print certain staves of a song?
In File: Page Setup, Contents tab you may check the staves and/or groups you want to print.

Insert: Spacer
For more control over the printed score, the command Insert: Space can be used to create horizontal space
on a staff.

Insert: Boundary Change
For more control over the printed score, the command Insert: Boundary Change can be used to

• adjust space above and below a staff in specific areas

• collapse (hide) the multi-measure rest section of the staff during printing multiple staves

• create a gap/break in the staff or start a new system on a new line or new page
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Chapter 10

Trouble Shooting
If you are having a problem, check this section.

Troubleshooting with Score Review

The Score Review command under the Tools menu is not only a summary of the song’s staves, but also
helpful in troubleshooting sound problems. Following is a list of the fields in Score Review and how they
can help:

Name: In general, this will show how many staves are in a song, even if some are layered or hidden. This
may help with other people’s files, if they refer to staves by name instead of position, you can quickly see
where the staff is located. It could also help you to keep your staves in order if you are working on an
Orchestral Piece. The name is set on the General tab of Staff Properties.

Mute:  This field provides a quick check to see if you have muted a staff and did not intend to leave it
muted. Y = muted and N = not muted. This can be set on the MIDI tab of Staff Properties, Tools: Mute List
or the Mute Staff icon.

Device: The device correlates to the Play back device setting on the MIDI tab of Staff Properties. These
then correlate to the Devices used by play back set in Tools: Options, MIDI. How this would help in
trouble shooting is, if you received a file and a staff was not sounding (and it was not muted), it may be that
they had that staff assigned to a device that you do not have a play back device assigned to.

Channel: MIDI devices can support up to 16 channels. Each channel can only handle one instrument patch
at a time. If you wonder why the violin is sounding like a flute instead, it may be that you have both staves
assigned to the same channel. You need to change the channel for one staff. Or, if your trumpet staff is
making percussion sounds, you can check and find that it is assigned to the percussion channel (10 or 16).
Similarly, volume and other performance parameters can only be controlled by one channel. So even if you
have 2 piano staves assigned to the same channel, which would normally be OK, if you want a different
volume for one staff, they will need to be on different channel. Channel is set with Staff: Staff Properties,
MIDI, Channel.

Patch: Knowing the patch can help you review what instruments you have assigned; as well as, verify
proper channel alignment (as discussed above). This is set with Staff: Staff Properties, Instruments, MIDI
Patch Instructions.

Trans: If you have a staff that is sounding at a different pitch than it is notated, the Transposition field can
help. Transposition is controlled by the "Update staff play back transposition" checkbox in Tools:
Transpose staff. When checked, the results after the transpose will sound at the same pitch, even though
you transposed. If you did not mean to leave this checked, you can reverse the effect by going into Staff
Properties (F2), the Midi Tab, and changing the Transposition field to "+0" (example), rather than the "+3"
(example) that it was changed to after the Tools: Transpose command was used.

From Score Review, if you need to edit any of the fields, click the Goto Staff Properties… and you will be
taken to the Staff Properties Dialog box. After making the changes and clicking OK, you will be brought
back to the Score Review dialog box.
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Playback and Recording Problems

How do I get play back to work?

Make sure that the MIDI Mapper is the ONLY device selected for Devices used by play back in Tools:
Options, MIDI. You may have several devices listed but it will be best to start with just the MIDI Mapper.

Make sure you do not have other sound applications open that may hold the sound card and not let other
application use it (MIDI players, etc).

Also, make sure that the volume for MIDI is turned up, either on the speaker or, more likely, the Windows
mixer panel. In NoteWorthy Composer, go to Tools: Windows Volume Control and make sure that all
volumes are up.

If that does not work.....

The first thing to note is that sound cards support a variety of sound generation methods. For starters, the
audio out from a CD player may be run through the amplifier in your sound card to generate sound. In
addition, almost all sound cards include a digital audio section that works with audio samples, such as
*.WAV files. Neither of these sound types are MIDI sound. Your card, and your Windows system, must be
configured for MIDI, whether by you, or an installer provided with your card.

Why is one staff playing back percussion/drum sound s?

Most sound cards have a percussion channel on channel 10. The staff that is playing back percussion
sounds is set to this channel. You need to change the channel for this staff by going to Staff: Staff
Properties, Midi tab, Channel.

Why are my notes highlighting before they are playe d?

Most likely, the computer is using a soft synth with a very high note latency (in other words, the notes are
not being played by the computer when NoteWorthy Composer asks them to be played). Switching to a
synth built into a sound card will usually solve this, as "real synths" generally have a very small play
latency compared to soft synths.

For more discussion regarding soft synths, see the online community.

Why do I get 2 notes, when I only press one on my M IDI keyboard?

If you press one note on your MIDI keyboard, but get two notes shown in NoteWorthy Composer, one of
two things is happening:

1. Your keyboard is actually double triggering the notes

2. You have the MIDI echo feature on, and are echoing MIDI input back out to the keyboard, which
is then repeated back to NWC on input, causing a loop. If you are using the echo feature, try
turning it off. Tools: Options, Record tab, Echo MIDI Input
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How do I get a MIDI keyboard to work with NWC?

To get MIDI keyboard input to work, here are a few things to try:

• Make sure your keyboard is MIDI capable.
• Make sure the cables are connected correctly. Some systems like MIDI In to MIDI In and some

like MIDI In to MIDI Out. Even though there is a standard some do it the opposite.
• In NWC, Tools:Options, Record tab, make sure you have selected the In Port of your sound card.

(You may even want to go through each selection and test).
• Make sure you are following the proper procedures for MIDI keyboard input – as detailed in the

MIDI Recording section on page 70.

If you still cannot record, the problem is most likely the device driver for the input of your soundcard or
MIDI interface. You should re-install from the setup disk that came with your sound card or MIDI
interface. If this does not correct the problem, get the latest update driver software from your sound card
manufacturer.

The options listed in NoteWorthy Composer under Tools: Options, Record tab, Input Device are based on
the software drivers that you have installed for the hardware on your computer that would accept MIDI
input.

Devices that would accept MIDI input would be a sound card that includes a MIDI port or a hardware
MIDI interface. With these hardware devices, software drivers would be installed to control the hardware.

If you do not have any devices listed for Input Device, then you do not have the software drivers installed
or installed correctly. If you do not have the hardware, you would not have the software drivers.

If you want to have MIDI Input to Laptop, you will need a midi device that connects to the serial, parallel
or pcmcia slot and includes the connection interface. The device should come with drivers to install on your
computer. There has been some discussion about this in online community that may be helpful. After
reading over that, you may or may not need to post another question for other users' experiences and
solutions.

Display, Font and Print Problems

Why does the printed copy cut off the bottom copyri ght?

NoteWorthy Composer adds the print margins to the edge of the paper. It does not add the print margins to
your printer's unprintable area.

It is an option of the printer whether to send information to the application noting the printer's unprintable
area and the print start point. NoteWorthy Composer may not be receiving this info from your printer and
that is why Print Preview may show the copyright info on the page and then it does not print.

You will need to increase the bottom margin.

I got an error message that I have too many fonts. What do I do?

If your system is not seeing the fonts and giving you the warning message about full fonts, what is probably
full is the Windows/Fonts directory. Windows does not support an unlimited number of fonts, even though
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you can put a bunch in the directory. You need to remove some of the fonts you do not use (or move them
to another folder until you do need them).

Once you have moved or removed the fonts, restart your computer and re-install NoteWorthy Composer.

There are no staff lines. How do I correct this?

This is a bug, or problem, caused by your computer's display driver. The best solution is to get an updated
display driver that fixes the bug.

However, you can usually work around this problem by turning down, or disabling, graphic hardware
acceleration on your computer. Here is how to do it:

1. Open your system's Control Panel (Start | Settings | Control Panel)
2. Open the Display panel
3. Click on the Settings tab
4. Click the Advanced button
5. Click the Troubleshooting tab
6. Turn down the Hardware Acceleration slider (slide it to the left) until only basic functions are

enabled
7. Press OK in the Driver Properties box, then OK in the Display Properties box

Usually, this will correct the disappearing staff lines problem.

Why will my song file not print properly or at all?

If your song file prints only the first system running off the right side of the page or in another improper
manner, check the following:

1. Make sure you have notated the song correctly. When editing a song in NoteWorthy Composer,
the staff (or staves) extends to the right as if on a time axis. When you Print or Print Preview the
staff (or staves), it will be wrapped like in sheet music. Look at the sample song jingle.nwc. This
is a song with 2 staves. Notice that on the display screen, the staves move to the right. But if you
go to File: Print Preview, the staves are wrapped.

2. Make sure you have bar lines in the staves. NoteWorthy Composer uses the bar lines to break the
staff for printing. If you want a song without bar lines, you can mark the bar lines non-printing.
(Insert: Bar Line (Decorated), Visibility tab, Show on printed page: Never.)

3. Make sure you have the correct count per measure. Use Tools: Audit Bar Lines on each staff to
check this. If you need 2 voices on a staff, you will need to use Staff Layering (page 50).

4. Make sure all staves are the same length.

If your song file will still not play or print:

Check the flow of your song. If NoteWorthy Composer cannot follow the flow of the song, it may not be
able to print it and probably will not be able to play it. See page 51 for more on flow direction.
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Installation and Running Problems

What happens to my song files when I uninstall NoteWorthy Composer?

In general, your song files are safe when using the uninstall utility, as long as you saved them in a user
folder, rather than in the NoteWorthy Composer program files . If you have been saving your *.nwc files
inside the program folder, then you should immediately rearrange your filing system on your computer.
You should never store your own files in the same directory as program files. We recommend that you keep
your song files in a separate folder. You can configure NWC to use this folder from Tools | Options |
Folders. A good place to keep your own files is the "My Documents" folder on your C: partition. It is then
an easy process to backup your files, as they are all filed within a single folder hierarchy.

If you have not implemented a backup strategy, this should be your next planned action. Nothing is more
important than protecting your work product. You can always reinstall your programs, but you can never
recover your hard work unless you keep good and frequent backups.

What if I already uninstalled NWC and I cannot find  my song files?

Well, for starters, we should point out that you should always keep a backup of your work. Hard drives do
fail, and when they do, you will sing a sigh of relief when you have a current, working backup of your
work.

Backups aside, after uninstalling and then installing a new version, some people confuse the absence of
their NWC file history as having lost their song files (they no longer show up in the File | History
command). If this is the case, then you will find your song files on your computer in the location where
they are still stored. One way to track them down is to use the Windows "Find" command. From an
Explorer window, simply type Ctrl+F and the find utility will open. From there, you can search for your
files by name. Use the "Look in" box to specify all of your drives, select "Include subfolders", then specify
the name of one of the files that you are trying to find.

If this does not work, see the previous question for possible scenarios where you may have inadvertently
deleted your files. If you ever mistakenly delete your files, there are utilities on the market that might help
you to recover them, including Norton Utilities.

Why did I get "Corrupt Installation Detected" when running setup?

Symptoms:
You just downloaded a setup program from this site. When you try to run the setup program, a "Corrupt
Installation Detected" message is displayed.

Diagnosis:
This message is usually caused by one of two things:

1. The copy of the setup that you downloaded from the site was corrupted in the transfer process to your
computer. The remedy is to clear your browser cache and try again.

2. A quirk in the setup program might be causing this problem. If you are runnning the setup program
from a folder that includes embedded spaces or unicode characters, this message might be displayed.
When you run the setup program, try running it from a local hard drive, from a directory path such as
"C:\TEMP".
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Miscellaneous Problems

What does "improperly treated as an ASCII file" mea n?

This is caused by improperly downloading an NWC file as an ASCII file, usually from the Internet. This
can be the fault of a web server that has not properly set the MIME type for NWC files to a binary type. It
can also be caused by someone downloading an NWC file using an FTP program using an ASCII protocol.
This is not the fault of NoteWorthy Composer, and there is nothing we can do if the Recovery effort fails.

Why do I get an error message when I try to save a file?

If you are not able to save a *.nwc or a *.bak file, the problem is most likely one of the following:

1. The file, or disk where the file resides, is read-only (solution: use a different drive, or unmark the read-
only attribute for the file or files).

2. The disk is full (solution: clear disk space).

3. The disk is malfunctioning (solution: try a different drive).

4. The computer has some other problem that is just manifesting itself when using NWC save on this file
or files (perform computer diagnostics/virus checking/try a different drive).

Also, make sure you have not used a character not supported in file names. File names cannot contain the
following characters:
/ : * ? " < > |
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Appendix

Notation Symbols

If you do not know the name of a symbol to enter it in NoteWorthy Composer, the pictures below may help.
The following symbols can be found in the Insert menu. For additional help, symbols on the tool bars can
be identified by moving the insertion point over the icon and reading the tip that appears.

Clefs

Bar Lines (Decorated)

Key Signatures

Tempo Variance

I Breath Mark Caesura Mark

Fermata

Treble

a
Bass

b
Alto

c
Tenor 

c
Percussion

]

Local Repeat: Open J Close  (2)J        Master Repeat: Open J CloseJ

Single Double Broken Single Broken Double Section Open Section Close

y
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General MIDI Drum List

The table below lists the note pitches to use for various percussion sounds. See page 25 for instructions on
how to set up your song to play percussion sounds.

Note Pitch Percussion Sound Note Pitch Percussion Sound
B2 Acoustic Bass Drum B4 Ride Cymbal 2
C3 Bass Drum 1 C5 High Bongo
Db3 Side Stick Db5 Low Bongo
D3 Acoustic Snare D5 Mute High Conga
Eb3 Hand Clap Eb5 Open High Conga
E3 Electric Snare E5 Low Conga
F3 Low Floor Tom F5 High Timbale
F#3 Closed High Hat F#5 Low Timbale
G3 High Floor Tom G5 High Agogo
G#3 Pedal High Hat G#5 Low Agogo
A3 Low Tom A5 Cabasa
Bb3 Open High Hat Bb5 Maracas
B3 Low-Mid Tom B5 Short Whistle
C4 High-Mid Tom C6 Long Whistle
Db4 Crash Cymbal 1 Db6 Short Guiro
D4 High Tom D6 Long Guiro
Eb4 Ride Cymbal 1 Eb6 Claves
E4 Chinese Cymbal E6 High Wood Block
F4 Ride Bell F6 Low Wood Block
F#4 Tambourine F#6 Mute Cuica
G4 Splash Cymbal G6 Open Cuica
G#4 Cowbell G#6 Mute Triangle
A4 Crash Cymbal 2 A6 Open Triangle
Bb4 Vibraslap

The following staff section shows how a few of the percussion sounds would be notated for play back:

Clap Bell Bongo Triangle
Hand Cow Low Mute

b f k C4      

d k
a dk C6      

d k  
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General MIDI Instrument List

The table below lists the patch number and name. These instruments are selected with Insert: Instrument
Patch (if your sound card supports General MIDI).

1. Acoustic Grand Piano
2. Bright Acoustic Piano
3. Electric Grand Piano
4. Honky-tonk Piano
5. Rhodes Piano
6. Chorused Piano
7. Harsichord
8. Clavinet
9. Celesta
10. Glockenspiel
11. Music Box
12. Vibraphone
13. Marimba
14. Xylophone
15. Tubular Bells
16. Dulcimer
17. Hammond Organ
18. Percussive Organ
19. Rock Organ
20. Church Organ
21. Reed Organ
22. Accordian
23. Harmonica
24. Tango Accordian
25. Acoustic Guitar (nylon)
26. Acoustic Guitar (steel)
27. Electric Guitar (jazz)
28. Electric Guitar (clean)
29. Electric Guitar (muted)
30. Overdriven Guitar
31. Distortion Guitar
32. Guitar Harmonics
33. Acoustic Bass
34. Electric Bass (finger)
35. Electric Bass (pick)
36. Fretless Bass
37. Slap Bass 1
38. Slap Bass 2
39. Synth Bass 1
40. Synth Bass 2
41. Violin
42. Viola
43. Cello

44. Contrabass
45. Tremolo Strings
46. Pizzicato Strings
47. Orchestral Harp
48. Timpani
49. String Ensemble 1
50. String Ensemble 2
51. SynthStrings 1
52. SynthStrings 2
53. Choir Aahs
54. Voice Oohs
55. Synth Voice
56. Orchestra Hit
57. Trumpet
58. Trombone
59. Tuba
60. Muted Trumpet
61. French Horn
62. Brass Section
63. Synth Brass 1
64. Synth Brass 2
65. Soprano Sax
66. Alto Sax
67. Tenor Sax
68. Baritone Sax
69. Oboe
70. English Horn
71. Bassoon
72. Clarinet
73. Piccolo
74. Flute
75. Recorder
76. Pan Flute
77. Bottle Blow
78. Shakuhachi
79. Whistle
80. Ocarina
81. Lead 1 (square)
82. Lead 2 (sawtooth)
83. Lead 3 (caliope lead)
84. Lead 4 (chiff lead)
85. Lead 5 (charang)
86. Lead 6 (voice)

87. Lead 7 (Fifths)
88. Lead 8 (bass + lead)
89. Pad 1 (new age)
90. Pad 2 (warm)
91. Pad 3 (polysynth)
92. Pad 4 (choir)
93. Pad 5 (bowed)
94. Pad 6 (metallic)
95. Pad 7 (halo)
96. Pad 8 (sweep)
97. FX1 (rain)
98. FX2 (soundtrack)
99. FX3 (crystal)
100. FX4 (atmosphere)
101. FX5 (brightness)
102. FX6 (goblins)
103. FX7 (echoes)
104. FX8 (sci-fi)
105. Sitar
106. Banjo
107. Shamisen
108. Koto
109. Kalimba
110. Bagpipe
111. Fiddle
112. Shanai
113. TinkerBell
114. Agogo
115. Steel Drums
116. Woodblock
117. Taiko Drum
118. Melodic Tom
119. Synth Drum
120. Reverse Cymbal
121. Guitar Fret Noise
122. Breath Noise
123. Seashore
124. Bird Tweet
125. Telephone Ring
126. Helicopter
127. Applause
128. Gunshot
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a
 

F
A

C
E

E
G

B
D

F 

b A
C

E
G

G
B

D
F
A 

Note Positions and Names

Various Music Duration Names

American English Medieval
Whole Semibreve Semibrevis
Half Minim Minima
Quarter Crotchet Semiminima
Eighth Quaver Fusa
Sixteenth Semiquaver Semifusa
Thirty-second Demisemiquaver --
Sixty-fourth Hemidemisemiquaver --
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Keyboard Shortcuts Reference
To perform this action, Press To perform this action, Press
Insert a note Enter Creates a new score file Ctrl+N
Insert a rest Space Open an existing score file Ctrl+O
Add a chord member Ctrl+Enter Save active score file Ctrl+S
Insert a standard bar line Tab or * Access Help file F1
Select a whole duration 1 Close active window Ctrl+F4
Select a half duration 2 Switch to previous score Ctrl+F6
Select a quarter duration 3 Open Score Print dialog box Ctrl+P
Select a eighth duration 4 Paste as new file Shift+Ctrl+V
Select a 16th duration 5 Zoom in/out Alt+Plus/Minus
Select a 32nd duration 6 Zoom specification Alt+Equal
Select sm/lg duration -, + Cut the selection Ctrl+X
Select sm/lg duration Shift+Ctrl+↓,↑ Copy selection to clipboard Ctrl+C
Insert a spacer Insert Pastes clipboard contents Ctrl+V
Insert a grace note = Remove (clear) the selection Ctrl+Del
Toggle through noteheads Q Edit a single selected item Ctrl+E
Toggle natural sign 7 Redraw/refresh the score F9
Toggle flat sign 8 Redraw/refresh the active staff Ctrl+F9
Toggle sharp sign 9 Undo previous operation Ctrl+Z
Toggle the graphic crescendo Less than (<) Redo previous Undo Ctrl+Y
Toggle the graphic diminuendo Greater than (>) Reset attributes/center caret Zero (0)
Toggle tie attribute Slash (/) Undo previous operation Alt+Backspace
Toggles dot to double-dot to off Period (.) Find items on the staff Ctrl+F
Toggle slur attribute Semicolon (;) Find next item F3
Toggle accent attribute Exclamation (!) Access color toolbar Backslash (\)
Toggle staccato attribute Comma (,) Delete active staff Ctrl+D
Toggle tenuto attribute Underscore ( _ ) Add new staff Ctrl+A
Toggle marcato attribute ^ Activate top/bottom staff Ctrl+Home/End
Toggle staccatissimo attribute ‘ Activate one staff up/down Pg Up/ Pg Dn
Beam the selected note flags Ctrl+B Access user tools Alt+F8
Combine selection into triplet Ctrl+T Run last executable Ctrl+Alt+F8
Insert bar line (decorated) B, b Go to a specific measure Ctrl+G
Insert a clef C, c Delete item to right of caret Delete
Insert a dynamic D, d Delete chord member Ctrl+Backspace
Insert a dynamic variance Y, y Delete note or selection Backspace
Insert a flow direction F, f Move selected notes up, down Shift+Ctrl+↑, ↓
Insert a key signature K, k Move next measure left,right Ctrl+←, →
Insert a performance style P, p Select items to right, left Shift+→, ←
Insert a special ending S, s Move up, down an octave Ctrl+↑, ↓
Insert a sustain pedal U, u Move to start of staff Home
Insert a tempo T, t Move to end of staff End
Insert a tempo variance E, e Move active staff up/down Ctrl+Shift+PgU
Insert text X, x Edit filtered properties Ctrl+F3
Insert a time signature G, g Access staff properties F2
Insert an instrument change I, i Access properties dialog Alt+Enter
Access the multi-point control L, l Turn off stuck notes F6
Create or edit lyric lines Ctrl+L Access File Info Ctrl+I
Access Score Review R, r Viewer Mode F11
Access Mute List M, m Pause play Shift+F6
Select stem direction up/down Shift+↑/↓ Staff play Shift+F5
Access Multi-measure Rest
Start MIDI Play

[
F5

Record MIDI Input
Stop MIDI Play

F4
F6
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Command Summary

File menu
The File menu contains the necessary commands to open, save, and print NoteWorthy Composer files.

Command Icon Quick Key Function

New… Ctrl+N Create a new score file from scratch or using a predefined
template

Open… Ctrl+O Open an existing *.nwc score file or MIDI performance

Open
Backup…

Open a previous backup version of a *.nwc file

Open
Sample…

Open a sample file that is included with the program

Save Ctrl+S Save the score in the active edit window

Save As… Saves the score in the active window to a new file name and/or
file type

Save All Save all open score files which have been changed

Revert Revert the currently active score back to the version saved on
disk.

Close Close the currently active score

Import… Import and convert a *.mid file

Export… Export the current *.nwc file to a *.mid file

Info… Ctrl+I Specify authoring information about the active score

Page Setup… Set page display options when printing

Printer Setup.. Change the current printer configuration

Print Preview Preview what the printout of your score will look like
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Print… Ctrl+P Print the active score

History… Display scores which have been recently open

Exit Quit the program

Edit Menu
Most commands from the edit menu are designed to operate on the active staff of the active window.

Command Icon Quick Key Function

Undo Ctrl+Z Undo the previous operation

Redo Ctrl+Y Redo the previous Undo operation

Cut Ctrl+X Cutys the selection and places it in the clipboard

Copy Ctrl+C Copy the selection into the clipboard

Copy Special Copy the portion of the selection that fits on screen to the
clipboard as a graphic

Paste Ctrl+V Paste the contents of the clipboard

Paste As New
File

Shift+Ctrl+V Starts a new file using the notation data in the clipboard.

Clear Ctrl+Del Clear the selection (no effect on clipboard)

Select All Select everything in the active staff

Remove
Chord Note

Ctrl+
Backspace

Remove the member of a chord immediately on the left of the
insertion point

Beam Ctrl+B Beam the selected notes

Triplet Ctrl+T Convert the selected notes into triplets

Find… Ctrl+F Find the next matching notation element using criteria that you
specify

Find Next… F3
Finds the next matching notation element using criteria specified
in a prior Find operation
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Goto… Ctrl+G Move insertion point to the measure you specify

Lyrics… Ctrl+L Open the lyric editor dialog for the active staff

Filtered
Properties…

Ctrl+F3 Change the properties for selected objects that match a filter
expression

Properties… Alt+Enter Open the properties editor for the current selection

View Menu
This menu contains commands necessary to zoom in and out of the current score, as well as to control the
visibility of the tool bars.

Command Icon Quick Key Function

Show Active
Staff Edges

Show the top and bottom boundary edges for the currently active
staff

Show
Crosshair

Show crosshair guidelines at the insertion point

Show Label
Panel

Show or hide the entire staff label panel on the left side of the
editor

Show Bar
Number Panel

Show or hide the entire bar number panel on the top of the editor

Layering in
Edit Mode

Enable/disable staff layering while in edit mode

Viewer Mode F11 Places the editor in Viewer Mode, where hidden and editor only
elements are not shown

Zoom In Alt+Plus Zoom into the currently active score

Zoom Out Alt+Hyphen Zoom out of the currently active score

Zoom… Alt+Equal Specify a specific zoom level for the active score

Refresh Score F9 Redraw (refresh) the active score

Status Bar Toggle the visual status of the status bar

Tools Bars… Select which tool bars should be currently visible
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Staff Menu
This menu contains commands necessary to zoom in and out of the current score, as well as to control the
visibility of the tool bars.

Command Icon Quick Key Function

New Staff Ctrl+A Add a new staff to the current view of the score

Import
Recording…

Create a new staff by importing the most recent recorded MIDI
performance

Delete Staff Ctrl+D Remove the currently active staff

Move Staff… Move the currently active staff to another position in the score

Move Staff
Up

Ctrl+Shift+
Page Up

Move the currently active staff up one staff position

Move Staff
Down

Ctrl+Shift+
Page Down

Move the currently active staff down one staff position

Mute Staff Mute the active staff so that it does not sound during play back

Bracket with
Next

Start or extend an orchestral to the next staff

Brace with
Next

Start or extend a grand staff brace to the next staff

Connect Bars Connect bar lines to next staff

Layer with
Next

Layer the currently active staff with the staff below it

Staff
Properties…

F2 Edit the properties of the current staff
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Insert Menu
The insert menu contains the commands for adding notes, rests, and music symbols to the staff. Following
are the commands, icons and quick keys for the menu. The icons for specific clefs, time signatures, etc. are
not listed here, but ** indicates there icons available under View: Toolbars. Only the icons that open the
dialog box for the general command are shown.

Command Icon Quick Key Function

Note Enter Add a note

Rest Spacebar Add a rest

Chord
Member

Ctrl+Enter Add a note member to a chord

Bar Line Tab or * Add a standard bar line

Multi-measure
Rest…

[ Access the Multi-measure Rest dialog box

Spacer… Insert Insert an empty spacer into the staff

Boundary
Change…

] Dynamically control staff boundaries

Bar Line
(Decorated)...

B or b Add special bar lines (double, repeat, etc.)

Clef… ** C or c Add a clef

Dynamic… ** D or d Add dynamics such as ppp or mf

Dynamic
Variance…

** Y or y Add dynamic variance, such as crescendo

Flow
Direction…

F or f Add flow direction symbols such as To Coda

Key
Signature…

K or k Add a key signature

Performance
Style…

P or p Add a performance style, such as Legato

Special
Ending…

S or s Add special endings
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Sustain
Pedal…

** U or u Add sustain pedal symbols

Tempo… T or t Add tempo designations

Tempo
Variance…

** E or e Add tempo variances, such as fermata and accel.

Text… X or x Add a text expression of your choice

Time
Signature…

** G or g Add a time signature designation

Instrument
Change…

I or I Add a change of instrument

Multi-point
Controller…

L or l Add a generic MIDI controller
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Notes Menu
These commands are associated with note entry – note duration, noteheads, accidentals, etc.

Command Icon Quick Key Function

Under
Colors

\ Toggle through color icons  for notehead

Default Select the default item color

Item Color
1-7

Select item color 1-7

Under
Durations

+ or – To toggle through the duration icons, use + or -

Whole 1 Activate prior to adding a whole note/rest

Half 2 Activate prior to adding a half note/rest

Quarter 3 Activate prior to adding a quarter note/rest

Eighth 4 Activate prior to adding an eighth note/rest

Sixteenth 5 Activate prior to adding a sixteenth note/rest

Thirty-second 6 Activate prior to adding a thirty-second note/rest

Sixty-fourth Activate prior to adding a sixty-fourth note/rest

Grace = Future note will be a grace note or add/remove for selected note

Under
Noteheads

Q To toggle through the notehead icons, use Q

Standard Set note head to standard notehead

X Set note head to an X notehead
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Harmonic
Open
Diamond

Set note head to harmonic (open diamond) notehead

Blank Space Set note head to be blank (stem only)

Non-pitched Set non-pitched notehead

Diamond Set diamond notehead

Shape 1 do Set shape note ‘do’ notehead

Shape 2 re Set shape note ‘re’ notehead

Shape 3 mi Set shape note ‘mi’ notehead

Shape 4 fa Set shape note ‘fa’ notehead

Shape 4 fa
(alt)

Set alternate shape note ‘fa’ notehead

Shape 5 so Set shape note ‘so’ notehead

Shape 6 la Set shape note ‘la’ notehead

Shape 7 ti Set shape note ‘ti’ notehead

Under
Accidentals

Natural 7 Future note will include a natural sign or add to selected note

Flat 8 Future note will include a flat sign or add/remove for selected
note

Sharp 9 Future note will include a sharp sign or add/remove for selected
note

Double
Sharp

Future note will include a double-sharp sign or add/remove for
selected note

Double Flat Future note will include a double-flat sign or add/remove for
selected note
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In Main List

Crescendo < Add/remove a graphic crescendo to select notes

Diminuendo > Add/remove a graphic crescendo to select notes

Accent ! Future note will include an accent or add/remove for selected
note

Dot Period . Future note will include a dot or add/remove for selected note

Double-Dot Future note will include a double dot or add/remove for selected
note

Marcato ^ Future note will include a marcato or add/remove for selected
note

Slur Semicolon ; Apply slur to selected notes plus next note, the next two notes
entered or remove slur from selected notes

Staccatissimo ‘ Future note will include a staccatissimo or add/remove for
selected note

Staccato Comma , Future note will include a staccato or add/remove for selected
note

Tenuto Underscore _ Future note will include a tenuto or add/remove for selected note

Tie Slash / Apply tie to selected notes, the next two notes entered or remove
tie from selected notes

Stem Up Shift+Up Apply a stem up attribute to the next note entered or to the
selected note

Stem Down Shift+Down Apply a stem down attribute to the next note entered or to the
selected note

Persistent
Note Tools

Enable the selection of various note tools to persist even after a
note is added
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Tools Menu
This menu contains various tools for working with a score file.

Command Icon Quick Key Function

Record F4 Record MIDI input while playing the active score

Staff Play Shift+F5 Play just the active staff

Play F5 Play the active score

Pause Shift+F6 Pause playing song temporarily

Stop F6 Stop play or reset all configured devices

Windows
Volume
Control

Open the system volume control panel

Score
Review…

R or r Review the score in a list format

Layering
Tool…

Opens dialog box to quickly rework staff layers

Mute List… M or m Set and clear the mute status for the score parts from a list

MIDI Input
Active

Enable remote note entry via MIDI Input

Under Audit

Audit
Accidentals

Audit and polish the accidental assignments in the active staff

Audit Bar
Lines

Audit and replace the bar line structure of the active staff

Audit
Enharmonic
Spelling

Audit and re-spell notes to match the current key signature

Audit Note
Stems

Audit and polish the note stem directions for the active staff
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Automatic
Beam

Automatically beam flagged notes for the active staff

Transpose
Staff…

Transpose the active staff up or down in semitones

Force
Accidentals

Force all notes in active staff to be labeled with an accidental

Repeat Last
User Tool

Ctrl+Alt+F8 Run the last executed user tool again

User Tool… Alt+F8 Access User Tools list to Add, Edit, Remove

Options… Configure NoteWorthy Composer 2 application preferences

Window Menu
This menu contains commands to arrange and access open song files.

Command Icon Quick Key Function

Cascade Cascade all open windows that are not minimized

Tile Tile all open windows that are not minimized

Arrange Icons Arrange all minimized windows

Close All Close all open windows

Song List Short list of open windows which can be activated

More
Windows…

Complete list of open windows (more than 9 windows)



Appendices   99

Help Menu
The Help menu includes access to the help file and access to getting support and checking for updates.

Command Icon Quick Key Function

Contents F1 Access the list of contents for the Help file

Did you
know…

Access the “Did you Know?” Tips

Getting
Started

Open Getting Started section of Help file

Command
Reference

Open command list and associated help

Keyboard
Reference

Access the list of keyboard quick keys

Access
NoteWorthy
Software.com

Open NoteWorthySoftware.com in your web browser

About… Check version information
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Music Terms used in NoteWorthy Composer
The music terms in this glossary are available for use when notating with NoteWorthy Composer. Each
term can be found in the Insert menu of NoteWorthy Composer under the command matching the heading
below. For example, Pianissimo is defined under the heading Dynamic. To use a Pianissimo symbol (pp) in
NoteWorthy Composer, you would select the Dynamic command from the Insert menu.

Dynamics
Dynamics are terms or symbols that define the level in which the music is to be played. The dynamics
listed below are in order from soft to loud.

Dynamic Notated Performed as
Pianissimo pp Very soft
Piano p Soft
Mezzo Piano mp Moderately soft
Mezzo Forte mf Moderately loud
Forte f Loud
Fortissimo ff Very loud

Dynamic Variance
Dynamic Variances are terms or symbols indicating change from soft to loud or loud to soft.

Name Notated Performed as
Crescendo cresc. Gradually play louder
Decrescendo decresc Gradually play softer
Diminuendo dim. Play to diminish
Rinforzando rfz Play to reinforce
Sforzando sfz Play forcibly

Flow Direction
These terms are used to indicate the direction, or flow of play.

Name Performed as
Coda Tail/Marker for al Coda redirections
Segno Sign/Marker for Dal Segno redirections
Fine End play after a redirection
To Coda Go to the Coda
Da Capo (D.C.) From the beginning
D.C. al Coda Play from the beginning to the Coda
D.C. al Fine Play from the beginning to the Fine
Dal Segno From the Segno
D.S. al Coda Play from the Segno to the Coda
D.S. al Fine Play from the Segno to the Fine
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Performance Style
Performance style is the manner in which music is played. NoteWorthy Composer does not generally
change its play back style based on performance styles, except in the case of Legato/Tenuto.

Style Name Intended Performance Change
Ad Libitum Improvise as you wish
Animato Animated
Cantabile Allow for singing
Con brio Animated
Dolce Sweetly
Espressivo Expressive
Grazioso Gracefully
Legato Smooth and connected
Maestoso Majestically
Marcato Marked
Meno mosso Slower, less lively
Poco a poco Little by little
Più mosso Faster, more lively
Semplice Simply
Simile Similarly
Solo Alone
Sostenuto Sustained
Sotto Voce Toned down voice
Staccato Short and disconnected
Subito Suddenly
Tenuto Hold for full value
Tutti All
Volta Subito Turn quickly

Tempo Variance
These terms and symbols denote a change in speed from slow to fast or fast to slow.

Name Intended Change
Breath Mark Pause, take a breath
Caesura Break
Fermata Hold longer
Accelerando Increase speed
Allargando Slow down
Rallentando Decrease speed
Ritardando Gradually play slower
Ritenuto Hold back
Rubato Freely
Stringendo Hurry up
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Support for NoteWorthy Composer

For support in using NoteWorthy Composer, you may contact us via:

E-mail support@noteworthysoftware.com
Web http://NoteworthySoftware.com
Mail NoteWorthy Software, Inc.

PO Box 211
Valdese, NC 28690-0211
USA
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purpose without the express written permission of NoteWorthy Software, Inc.
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